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PowerNet Twin Client Overview
PowerNet Twin Client is a software package that provides VT100, VT220, TN3270 (Telnet 3270), and TN5250 (Telnet 5250) 
emulation on portable terminals. It includes an easy-to-use Windows program for configuring and downloading the software to 
the portable terminals.

Modes of Operation
PowerNet Twin Client operates in either of two modes: thick client or thin client.

• Thick client mode (also referred to as telnet client mode) provides a telnet connection directly to host computers and their 
applications.

• Thin client mode communicates directly with a PowerNet OpenAir or PowerNet AirLinc server, which in turn provides the 
connection to host computers and their applications.

The primary difference between the two modes is in processing load distribution: In thick mode, all application protocol 
processing is performed on the terminal, while in thin mode all of the processing takes place on an intermediate OpenAir or 
AirLinc server. Another important difference is optimization: In thin mode, the OpenAir or AirLinc server introduces display 
optimization, data compression, and several other techniques that can dramatically reduce wireless network traffic. These 
optimizations are not possible in thick mode.

All of the user interface features, functions, and capabilities remain the same, regardless of the mode of operation.

Major Features
PowerNet Twin Client for HHP terminals offers the following benefits:

• Simplicity: Twin Client is preset to match the default keyboard overlays and functionality of the HHP Telnet client. No special 
configuration procedures are required.

• Compatibility: Existing HHP installations that have been customized can be easily converted to PowerNet by importing the 
existing configuration file, and/or by using the alternate HHP -style terminal configuration menu system.

• Management: Administrators and integrators can monitor and modify the software revision and configuration of each portable 
terminal from any Windows PC attached to the TCP/IP network. Changes are downloaded to the terminals over the wireless 
LAN automatically.

• Diagnostics: Because Twin Client is fully integrated with PowerNet Vision, the network management tool, administrators and 
technicians can monitor terminal displays, keyboard activity, and diagnostic logs on the Twin Client terminals in real time, from 
any Windows PC attached to the TCP/IP network.

• Formatting: The PowerNet Terminal Screen Formatter feature is built-in, allowing integrators to tailor host application displays 
to suit the needs of the terminal operators without modifying the applications.

• Migration: Conversion to a PowerNet OpenAir or PowerNet AirLinc client-server environment is automatic because the "thin" 
client is included in the Twin Client software already downloaded to the terminal.

In This Manual
This manual is organized as follows:

• Chapter 1 provides an overview to the PowerNet Twin Client.
• Chapter 2 describes how to load the PowerNet Twin Client Manager software on a Windows 95, 98, or NT/2000 PC.
• Chapter 3 describes how to quickly configure the PowerNet Twin Client Manager and the terminal for automatic, over-the-air 

software download and subsequent Telnet session startup.
• Chapter 4 describes how to change the Standard setup options specific to VT, 3270, and 5250 emulations. The simple, time-

saving features for converting existing HHP Telnet client installations to PowerNet are also described here.
• Chapter 5 describes how to use the Advanced setup options for VT, 3270, and 5250 emulations. These options are used to 

customize keyboard, display, scanner, timer, alarm, and printer operation.
• Chapter 6 describes how to use the PowerNet advanced integration tools to further customize terminal operation. The creation 

and use of mapping, macro, dialog, and scanner control objects are described.
• Chapter 7 describes the use of the built-in PowerNet Formatter, and how to configure the portable terminal to use screen 

formatting.
• Chapter 8 describes how to use the Auto-Configuration tool to manage and automatically maintain the software configuration 

of all terminals on the wireless network. Also described are software management procedures and options that are unique to 
HHP terminals.

• Chapter 9 is a reference for the ISO 8859-1 and ASCII character sets.
• Chapter 10 is a reference for the default keyboard configurations for HHP terminals using PowerNet Twin Client in advanced 

mode. Figures and tables are included for 3270, 5250, and VT.
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Installation
This chapter describes the installation of the PowerNet Twin Client software on a Windows 95, 98, or NT/2000 PC. The software 
is available in the Partner's area of HHP's web site, www.hhp.com. 

Requirements

Installation of PowerNet Twin Client requires, at a minimum, the following:

• A Pentium-class processor
• 32 MB of RAM
• 10 MB of free hard disk space available
• Microsoft Windows 95, 98, or NT/2000 operating system

Downloading From the Web

The PowerNet Twin Client software package can be downloaded from the HHP web site at www.hhp.com. Click on Partners 
Enter Here and log in to the Partners web site. Under Technical Support, click on Software Downloads. Select the file named 
PowerNet Twin Client for HHP.

Running Setup from a Download File
The downloaded file is a compressed archive. After extraction using a utility such as WinZip, folders are created on the hard disk 
as shown in the following figure.

Click on the Setup application and proceed to the following section entitled Installation for further instructions.

Note: If a previous version of PowerNet Twin Client exists on your system, un-install it, reboot your computer, and verify that the 
PowerNet Twin Client directory has been completely removed from your system.
owerNet Twin Client™ Version 7.4.0 User’s Guide 2 - 1
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Installation

The InstallShield wizard runs and presents the following screen:

Click on Next to begin the installation process. The Choose Destination Location window appears. The default folder is 
PowerNet.To change the default Destination Location, click on Browse and select a location. Then click on Next. 
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This default may be changed either by selecting an existing program group or by typing in a new name at the prompt. Then click 
on Next.

When the installation is complete, reboot the system to initialize the PowerNet software.

a. To reboot the system immediately, click on Finish.

b. To reboot later, click on <No, I will restart my computer later.> and then click on Finish.
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To run the TwinClient Configuration Wizard, click on Start>Programs>PowerNet>Twin Client Manager. From the File menu, 
choose Wizard.The TwinClient Configuration Wizard runs and presents the following screen:

Click on Next to begin the installation process. The following screen displays:
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Choose the terminal model, radio type, and communications port, and then click on Next.

Enter the IP address information and choose the emulation. Then click on Next.
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Enter the authorization code, or choose the Enable AirLoader functionality feature on the next screen to load the individual 
authorization codes for each terminal onto the terminal automatically. Click on Next. The PowerNet Twin Client Manager and 
terminal files are then installed.

Enable the second box to download the program files via the serial port when the wizard closes. Click on Finish to reboot the 
system to initialize the PowerNet software.
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Adding Licenses

This feature allows you to increase the number of users you are allowed to authorize locally.

Transferring Authorizations
Transferring authorization allows you to move the remaining portion of your site license from one computer to another computer. 
Once the transfer is complete, the computer from which authorization was transferred will no longer be able to authorize 
terminals. The new computer will be able to authorize the number of terminals remaining on the existing site license.

Running the Manager

The PowerNet Twin Client Manager is the utility that manages the terminal software and configurations.

Select Start>Programs>PowerNet>TwinClient Manager. The PowerNet Twin Client Manager screen appears as shown in the 
following figure. This is the administrator's main screen; and all functions are accessed from its menu bar, tool bar, and tabs.
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Menu Bar

The menu bar provides access to the functions used to configure the terminals and manage their software. Subsequent chapters 
of this manual explain each menus and it options.

Toolbar

Under the menu bar, the tool bar provides shortcuts to major features. The toolbar can be turned on or off by changing the Toolbar 
parameter found on the View menu. The shortcuts available from the toolbar are as follows:

The PowerNet Twin Client Manager is now successfully installed and ready for use. Chapter 3 provides detailed instructions for 
quickly configuring the terminal and starting a telnet session.

Create a new terminal configuration.

Open an existing terminal configuration.

Save the current terminal configuration.

Download the configuration to terminal.

Download software to terminal.

Automatically configure terminals over the wireless 
network.

PowerNet Twin Client Manager version.
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Quick Start
This chapter describes how to prepare the Twin Client Manager and the HHP terminal for a Telnet session with the host. 
Following an initial serial download, the terminal software and configuration is managed automatically, over the wireless network.

Note: HHP terminals are normally delivered with HHP files pre-installed. However, if the terminal does not have those files 
installed refer to Software Management beginning on page 8-1, before proceeding.

Configuring the Manager

The first step is to configure the Twin Client Manager to meet site-specific requirements, and then prepare it for the automatic 
management of the terminal software and IP addresses. This simple procedure will require only a few minutes to complete.

Setting the Emulation
1. Click Start>Programs>PowerNet>Twin Client Manager.

2. Click Settings as shown below.

3. Select Emulation.

4. Select the desired emulation, then click OK.
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Setting the Servers
The Servers are the Telnet host systems the terminals will access.

To set these addresses from the Settings menu, click on Servers and then click on Add. Enter the name of each server, its IP 
Address and IP port (normally 23 for Telnet servers), and emulation type. Then click OK.

Repeat this step for each telnet server the terminals are required to access. If an error is made in the name, IP Address, IP Port 
number, or Terminal emulation type, click on the line that is in error and then click on the Edit button to make the corrections.

Setting Terminal Model and COM Port
To select a specific HHP terminal model and keypad, or to change the COM port assignment, click on the Options menu as 
shown.
3 - 2  PowerNet Twin Client™ Version 7.4.0 User’s Guide



To maintain compatibility with existing HHP Telnet client keyboard layouts, a specific terminal model and keypad must be 
selected from the Terminal Model window.

Saving the Configuration
Click File, Save As, and enter a name for this configuration.
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For the purposes of this example, the name is VT220. 

Configuring the Terminal for Download

HHP terminals are delivered with system software. For additional information concerning system software, refer to “Software 
Management” on page 1 before proceeding.

The terminal is prepared for the addition of PowerNet by booting to safe mode, selecting the program loader on the terminal, and 
setting the serial port parameters as described in this section. This simple procedure is described in the following sections, and 
requires only a few minutes to complete.

Connecting the Terminal for Download

For Dolphin 7200 and 74XX devices, the terminal download requires a serial connection between the terminal and the PC. For 
Dolphin 95XX devices, the terminal download requires a either a serial or a USB connection. 

Connect the terminal either directly to the PC using a serial/USB cable or via an HHP charging/communication cradle such as a 
HomeBase. If a HomeBase is being used, make sure it is connected to the serial/USB port on the PC.

Command Mode Safe Boot

See the chart below for the key sequences for booting the 7200 and 7500 terminals to safe mode. Note: The reboot keys always 
restart the terminal. However, the <on scan> key must be depressed while rebooting for the 7200 or 7500 terminal to come up 
in safe mode. 

Table 1: Command Mode Safe Boot Sequences

Terminal Model & Keypad Key Sequence

7200, 7500 To exit to DOS prompt from main screen, press <shift> to 
view uppercase mode, press <C> for Edit Functions screen, 
press <F2> to Exit, and press <enter>. Press <shift> 
<bksp> and <on scan> keys simultaneously, then 
release.Press and hold <on scan> key until terminal finishes 
rebooting

74XX/95XX Press Shift and Ctrl keys simultaneously, hold for 10 
seconds, and release (often referred to as warm boot).
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Cold Booting the Terminal

Downloading from the HomeBase to the Dolphin 7200

Run the Dolphin Wizard step 1 to set the baud rate to 57600. Also in the Dolphin Wizard, perform step 6 to install the TCP/IP 
stack.

The terminal then associates with an access point, contacts the Twin Client Manager, and then downloads the program, 
configuration, and IP address of the terminal.

During the download, progress messages are displayed on the terminal. Pauses in activity of up to 10 seconds will be observed 
as the terminal writes to FLASH. The download requires approximately 2 minutes to complete. The following table describes the 
error messages that will be displayed on the terminal in the event of a download failure, and can be used as a guide to correcting 
the problem.

Table 2: Cold Boot Sequences

Terminal Model & Keypad Key Sequence

7200, 7500 To exit to DOS prompt from main screen, press <shift> to 
view uppercase mode, press <C> for Edit Functions screen, 
press <F2> to Exit, and press <enter>. Press <shift> 
<bksp> and <on scan> keys simultaneously, then release.

74XX/95XX Press ESC and CTRL keys simultaneously, hold for 10 
seconds, then release. (Often referred to as cold boot.)

Error Indication Possible Cause Corrective Action

NOT Associated Invalid Security ID Run RFSETUP and set Security ID to match the 
access point. See Chapter 4 for instructions.

No AirLoad Manager Found AirLoad Manager not active, or 
not installed on the LAN segment

Ensure that the PC with Twin Client Manager is on 
the same segment and that the PC is operating. If 
the PC is not on the same segment, enter the 
address of the PC in response to the terminal 
prompt.

Manager not Active Previously identified AirLoad 
Manager is no longer found.

Same as above.

Unable to open connection IP stack on terminal failed to load. Reload HHP driver files.

Timeout waiting for data Transient communications failure
Reboot terminal.

If problem persists, check the RFSYNC.log in the 
PowerNetTN directory.

Download aborted Socket closed during download
Ensure PC is operating. Reboot terminal and retry.

Manager inactive PC not operating
Restart the PC.
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After taking the corrective action, the terminal must be cold booted again. A successful wireless connection and download is 
indicated by the display of the PowerNet main menu shown below:

The terminal is now ready to establish a Telnet session with the host system.

TwinClient, TNVT

©1991-2001,

Connect

Any Key To

Continue
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Standard Setup
The default terminal setup is sufficient for most installations. However, to meet site-specific requirements it may be necessary to 
customize terminal operation. The standard setup options simplify this process and can be modified using any one of the 
following methods:

• Using the Twin Client Manager.
• Using the PowerNet terminal menu system.

This chapter describes how to use the Twin Client Manager, the terminal menu systems, and barcodes to setup the terminal. 
Also described are the methods for authorizing the terminal software.

Standard Settings

The Twin Client Manager provides a Standard Settings tab for automatic setup of the terminals. The options within this tab vary 
according to the emulation selected, each of which is described in the following sections.

VT Settings

Select the VT emulation setup by clicking on the Settings menu and then the Emulation menu, as shown below.

Then click on the VT100, or VT220, as shown below.
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Click on OK after the selection is made, and return to the main Twin Client Manager menu. The standard settings tab will now 
reflect the settings for VT emulation.

Quadrant Mode

This scrolling list option defines the rules by which the terminal display is positioned in the larger host display. As defined by Twin 
Client, quadrants are fixed position "windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position.

Font Size

These check boxes enable (checked) or disable (un-checked) the display of characters in double high and double wide font.

Key Click

This option is used to automatically transmit a keystroke to the VT100 host when the VT100 field matches the selected attribute. 
The automatic keystroke generation can be based on whether the input is scanned, or keyed, or both.

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating no printer is attached.
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5250 Settings

Select the 5250 emulation setup by clicking on the Settings menu and then the Emulation menu, as shown below.

Then click on the 5250 selection, as shown below.

Click on OK after the selection is made, and return to the main Twin Client Manager menu. The standard settings tab will now 
reflect the settings for 5250 emulation.

Quadrant Mode

This scrolling list option defines the rules by which the terminal display is positioned in the larger host display. As defined by Twin 
Client, quadrants are fixed position "windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position.
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Font Size

These check boxes enable (checked) or disable (un-checked) the display of characters in double high and double wide font.

Key Click

This option is used to automatically transmit a keystroke to the 5250 host when the 5250 field matches the selected attribute. 
The automatic keystroke generation can be based on whether the input is scanned, or keyed, or both.

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating no printer is attached.

3270 Settings

Select the 3270 emulation setup by clicking on the Settings menu and then the Emulation menu, as shown below.

Then click on the 3270 selection, as shown below.
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Click on OK after the selection is made, and return to the main Twin Client Manager menu. The standard settings tab will now 
reflect the settings for 3270 emulation.

Quadrant Mode

This scrolling list option defines the rules by which the terminal display is positioned in the larger host display. As defined by Twin 
Client, quadrants are fixed position "windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position.

Double High and Double Wide Font

These check boxes enable (checked) or disable (un-checked) the display of characters in the double-high and double-wide fonts.

Key Click

This option is used to automatically transmit a keystroke to the 3270 host when the 3270 field matches the selected attribute. 
The automatic keystroke generation can be based on whether the input is scanned, or keyed, or both.

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating no printer is attached.
PowerNet Twin Client™ Version 7.4.0 User’s Guide 4 - 5



Terminal Setup Using PowerNet Menus

The Twin Client terminal software provides an internal menu system for configuring certain parameters on the terminal and for 
switching between "thin" and "thick" mode of operation. To access this menu system, press uppercase C at the startup screen 
as shown in the following figure.

Use the UP-ARROW and DOWN-ARROW keys to navigate the menu, and press ENTER to select the highlighted option. Each 
menu option is described in the following sections.

Edit Mobile Unit IP

Note: This applies only to the 7200 terminal.

The IP list contains the terminal IP address, the Subnet Mask and the Router IP address. Enter the appropriate address and 
select <F3> to save and/or <F7> to Quit.

Edit Server/Host IPs

If the host IP address or addresses were not pre-configured as described earlier in the section Setting the Servers, or if you wish 
to change those settings using the terminal menus, select Edit Host List and enter up to four Host IP addresses as required.

Press <F3> to save the configurations.

PowerNet

©1991-2001,Connect, Inc.

Any Key to Continue

IP    206.232.71.38

SN    255.255.255.0

RT    206.232.71. 1

<F3> Save    <F7> Quit

Host 0

IP 206.183.67.155

Port 23

<F3> Save    <F7> Quit
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Edit Radio Option

Note: This applies only to the 7200 terminal.

This function acts as a password to join the radio network. Terminals associating with an Access Point must supply a matching 
value, determined by their configurations, or their association requests will be ignored.

Edit the Authorization/License Key

The client software can be authorized automatically, as described in the next section. This menu option permits authorization of 
each terminal manually. Select Edit Authorization to obtain the terminal's Identification Code, which is then used to obtain the 
Authorization code from the Connect web site as described in the next section.

The 12-digit hexadecimal value displayed at the top of the terminal screen is the Identification Code for the terminal.

Type the authorization code into the field as it appears on the WEB site. Punctuation characters, such as the hyphen (-), are 
required. Press <F3> to save the authorization code.

Switch Client Modes

The PowerNet Twin Client normally operates in "thick" mode, which provides direct connection to Telnet hosts. It can also operate 
in "thin" mode, through a PowerNet OpenAir server. Select the Switch Modes menu option to switch between thin and thick 
modes of operation. Note that the host port address for the PowerNet OpenAir servers is 1800, which must also be changed in 
the Edit Host List menu described at the beginning of this section.

Run Client Emulator

After all desired changes have been made, select the Run Emulator option to return to the PowerNet main menu. Then press 
any key to establish the Telnet session and begin emulation. Refer to Chapter 3, for further instructions on starting a telnet 
session.

Authorizing PowerNet

Each PowerNet Twin Client will run for 30 minutes at a time without authorization. Uninterrupted operation for a production 
environment is the result of authorizing the software. Authorization codes are obtained from HHP. Please contact your local HHP 
sales representative for details.

ID      

tsunami____________

<F3> Save     <F7> 

Quit

00A0F826E614

Authorization

      ----------------

----------------

-

not authorized
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Manual Authorization
The procedure for manually setting the Authorization code on the terminal is described in the previous section entitled Editing 
the Authorization.
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Advanced Setup
The PowerNet Twin Client permits the customization of all aspects of terminal operation without custom programming. This 
chapter describes all of the advanced setup options. Additional advanced customization features, using the Object Editors, are 
described in Chapter 6.

Experienced HHP installers accustomed to performing customizations by manually-editing the HHP Telnet client configuration 
file will find this interface easier to use. However, those who prefer the file editing method can still do so, and still achieve the 
same result, by using the Import option described in the previous chapter.

Selecting the Advanced Setup

The Twin Client Manager is installed in the Standard Setup mode. To change to the Advanced mode, click on the View menu 
and then on Advanced.

As a result, a new set of tabs is displayed, as shown below.

The following sections in this chapter describe each of the tabs and the options within each tab.
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Customizing the Keyboard
Clicking on the Keyboard tab displays the setup options related to the terminal keyboard and its operation.

End Key

This scrolling list selection is used to set the terminal key that terminates both the host connection and the wireless session. The 
default is pf10.

Auto Send Key

This scrolling list selection is used to set the keystroke to be sent automatically by the terminal when an input field on the terminal 
is filled with keyed input. That is, if an input field is 9 characters long, and 9 characters are manually keyed into the field, the Auto 
Send key is automatically transmitted with the 9 characters. The default is tab. Selecting noop disables this feature.

Note:Selecting the Length Check option on the Scanner tab disables the Auto Send Key.

Key Click

This check box enables (checked) or disables (un-checked) audible key clicks from the terminal. Default is on (checked).

Case Conversion

This scrolling list selection allows automatic conversion of keyed input to upper or lower case. The default value is none, meaning 
no conversion takes place.
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Mapping Object

This feature of PowerNet Twin Client allows for custom keyboard development. For example, the tab key can changed to 
generate a pf4. This is an advanced integration tool and its use is described in Chapter 6.

Macro Object (VT Only)

This feature is used to assign a key sequence to a specific terminal key. For example, the PF1 key can be set to generate a 
sequence such as receiving. This is an advanced integration tool and its use is described in Chapter 6.

Mode (VT Only)

This scrolling list selection controls the transmission characteristics of the VT emulations. In char mode, each keystroke 
generates an individual transmission. In block mode, a transmission takes place only after a control key, such as ENTER or a 
PF key, is depressed. The block mode is more efficient. Refer to See “Advanced Display Options for VT” on page 19, for more 
details on setting block mode operation.

Auto EOF (3270 only)

This check box option enables (checked) or disables (un-checked) the automatic erasure of all data in a field prior to keyed or 
scanned data input. The default value is disabled (un-checked).

Clear First (3270 only)

This check box option enables (checked) or disables (un-checked) the automatic erasure of all data in a field prior to keyed or 
scanned data input. The default value is disabled (un-checked).

Serial Input

This check box is used to accept input from the serial port of the Dolphin 7300/74XX/95XX (e.g., input scanner [3800])

Advanced (3270 only)

Clicking the Advanced button brings up the Advanced 3270 Keyboard screen and provides a variety of special key generation 
options. This is an advanced integration tool and its use is described in Chapter 6.

Customizing the Display

Clicking on the Display tab shows the options related to the terminal display and its operation.
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Quadrant Mode

This scrolling list option defines the rules by which the terminal display is positioned in the larger host display. As defined by Twin 
Client, quadrants are fixed position "windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant boundaries result in a shift to the left in order to locate 
as much of the current input field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries. Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column (x,y) coordinates in the host display. The 
coordinates are zero-based.

Lock Row Defines the Y coordinate for display position locking. Range is zero (0) to maximum number of rows on the host 
screen. Default is zero (0).

Lock Column Defines the X coordinate for display position locking. Range is zero (0) to the maximum number of columns on 
the host screen. Default is zero (0).

Scroll Mode

This scrolling list option selects the rule used for moving the terminal display within the host display using the viewing keys.

Half scrolls the terminal display in half-screen increments. For example, given a 16-column screen, the screen is scrolled left and 
right 8 columns at a time.
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Full scrolls the terminal display in full screen increments. For example, given a 16-column screen, the screen is scrolled left and 
right 16 columns at a time.

Language

This scrolling list option selects the display character mapping and the translation table used for error messages displayed on 
the terminal. The default value is English. The file umsgs.txt, which is installed with PowerNet Twin Client, contains all of the 
current language translations.

Cursor Appearance

This scrolling list option selects the manner in which the cursor is displayed on the terminal. The default value is hard.

Type   Appearance

Soft Blinking Underscore (_)

hard  Blinking Block     n

hide None

Mapping Object

This feature is used to modify the displayed character set. This is an advanced integration option and its use is described in 
Advanced Integration beginning on page 6-1.

Dialog Object

This feature is used to build session automation scripts, and is an advanced integration option described in Chapter 6.

Formatting

This feature is used to re-format the host display onto the terminal display. This is an advanced integration option and is described 
in Advanced Integration beginning on page 6-1.

Relocation Group

This option group allows rows of the host display to be relocated automatically. This option is particularly useful when the 
application generates important error messages on a specific row that is not necessarily within the terminal's display area.

Source

Defines the starting row (zero-based) in the host display that is relocated to the destination row of the host display. The default 
is zero (0).

Destination

Defines the starting source row location (zero-based) in the host display. Default is zero (0).

Row Count

Specifies the number of host display rows to be relocated, starting with the row defined by the Source option and continuing from 
top to bottom of the display. The default, zero (0), disables row relocation.

Move Blank

This check box enables unconditional relocation (checked), or enables relocation only when data is present on the source row 
or rows (un-checked). The default is un-checked.

Reverse Video
This check box enables (checked), or disables (un-checked), the processing of the reverse video display attribute on the terminal. 
The default value is on (checked).
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Wait Message

This check box enables (checked), or disables (unchecked), the display of the message Waiting for Data on the terminal display. 
This message is used to indicate that the terminal has transmitted data to the host application and is waiting for a response. The 
default value is enabled (checked).

Default Data (3270/5250 only)

This check box enables (checked), or disables (unchecked), editing of data present in the current input field prior to entry of new 
data by the terminal operator.

Double High and Double Wide
These check boxes enable (checked), or disable (unchecked), the display of characters on the terminal screen in double high 
and double wide fonts, respectively.

Advanced (VT only)

This button accesses setup options for controlling all aspects of VT display attribute mapping and masking. This is an advanced 
integration tool and its use is described in Advanced Integration beginning on page 6-1.

Customizing the Scanner

Clicking on the Scanner tab shows the options related to the terminal scanner and its operation.

Send Key

This scrolling list option defines the control key automatically transmitted with scanned data. The list of keys depends on the type 
of emulation in use. The noop key indicates that no automatic control key will be sent. The default value is ENTER.
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Scan Ahead

This feature is not supported on HHP Dolphin terminals. 

Length Check

This check box option enables (checked), or disables (unchecked), scanned input data length checking. When this option is 
enabled and the scanned input data exceeds the length of the input field, an error message is automatically generated on the 
terminal and the data is not transmitted. The default value is disabled (unchecked).

Note: Enabling Length Check disables the Truncation option (described below).

Truncation

This check box option enables (checked), or disables (unchecked), the automatic truncation of scanned data that is greater than 
the length of the input field. With both Truncation and Length Checking disabled, oversized scans are automatically applied to 
subsequent input fields as needed. If either option is enabled, this automatic application is disabled. The default value is disabled 
(unchecked).

Stripping

This scrolling list option controls the rule for automatically removing trailing spaces and underscore characters. The rules are 
defined as follows:

Rule Operation

off No stripping is performed.

space Trailing spaces are stripped.

score Trailing underscores are stripped.

both Both trailing spaces and underscores are stripped.

Binary-128
This check box enables (checked), or disables (unchecked), the processing of binary code 128 bar codes on the terminal. The 
default value is enabled (checked).

Caution: If this option is disabled and binary-128 barcodes are used, the results are unpredictable.

Data Mapping, Data Editor, and Decoder Control
These are advanced integration tools and are described in Chapter 6.

Scanner Type
This scrolling list option defines the type of special scanner attachment in use, if present.

External Scanner Setup

RF terminals can be ordered with an Internal scanner or they can support an external scanner. The external scanner is connected 
to the bottom of the terminal through the serial port. This requires the RS-232 adapter be installed. The external scanner can be 
made to work even if an internal scanner is present. However, scanner decoder controls only apply to the internal scanner as the 
user only has access to the internal decoder.

The external scanner must be a serial based scanner. These are scanners that have on board decoder hardware/software and 
output their signals by normal RS-232 signaling methods. These external scanners are controlled by their respective 
manufacturers' program controls provided in the manual accompanying the scanner from the manufacturer.

The serial data stream, which the scanner outputs, needs to be in specific data format and speed. The RF terminal user manual 
has the setup for some popular scanners in this manual. It also includes the required bar codes to setup these scanners.

The following is an example of a setup for an RF terminal.

The order in which to set up the scanner is: 

1 - (SET RS-232C DEFAULTS) 
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2 - (SET ALL DEFAULTS) 

3 - RS-232 HOST BAUD RATE (9600) 

4 - RS-232 HOST PARITY (NONE) 

5 - RS-232 HOST DATA TRANSMISSION FORMATS (<DATA><SUFFIX>) 

6 - RS-232 HOST PREFIX/SUFFIX VALUES (SUFFIX) 

7 - RS-232 HOST PREFIX/SUFFIX VALUES (<1><0><1><3>)

Setting Log Levels

The terminal maintains a logging facility that can be used by Technical Support and Engineering to assist in problem resolution. 
These levels should always be set to zero (0) and can be adjusted during a telnet session, using the PowerNet Vision network 
management tool.

Customizing Timers

Clicking on the Timers tab shows the options related to the terminal timers, as shown below.
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Timers Group
Radio

This numeric input field defines the length of time, in seconds, during which the terminal activates the radio and waits for a 
response from the host application. After the time is exceeded, an error message is displayed on the terminal. The default value 
is 120.

Power

This numeric input field defines the length of the time, in seconds, after which inactivity of the scanner, keyboard, or radio results 
in a power saving shutdown of the terminal. The default is 300 (5 minutes).

Backlight

This numeric input field defines the length of time, in seconds, during which the terminal's display backlight remains on after 
keyboard or scanner input. When set to a value other than 0, the terminal turns on the backlight for the amount of time specified. 
Backlight use reduces battery life. The default value is 5.

Keepalive (3270/5250 only)

This option group circumvents host application connection timeouts by automatically generating the selected keystroke when the 
terminal is inactive for the specified period of time, in minutes.

Collection Timer (VT only)

This scrolling list option specifies the number of milliseconds the terminal waits for inactivity from the host before processing 
received data. This feature is useful in situations where the application and network latency fragments host transmissions to the 
terminal, and also when host applications generate intermediate displays that are not used. The default value is 100.

Note: For maximum performance, adjust the collection time to 30-50ms when Mode on the Keyboard tab is set to char.

Customizing Alarms

Clicking on the Alarm tab shows the options related to the terminal alarm mechanisms, as shown below.

Mode

This scrolling list option defines the operation of the audible alarm and scanner light on the terminal. Default is bell.

• Off disables the audible alarm.
• Bell enables the audible alarm as a double beep.
• Flash enables the scan indicator light as the alarm - no audible alarm sounds.
PowerNet Twin Client™ Version 7.4.0 User’s Guide 5 - 9



• Both enables the double beep and the scan indicator light as the alarm.
• Spec1 enables the audible alarm as a single beep.
• Spec2 enables a single beep and the scan indicator light as the alarm.

Volume

This scrolling list option set the volume of the audible alarm. The default is setting is hi.

Duration & Frequency

The next two options, duration and frequency, are used to make a distinction between alarms and scan decode tones when the 
Mode is set to spec1 or spec2.

Duration

This numeric entry field defines the length of the alarm sound in milliseconds. The default is 150.

Frequency

This numeric entry field defines the frequency of the audible alarm in Hertz. The default, zero (0) selects the terminal's factory-
set default which is terminal model dependent. The default value is 2048.

Allow Multiple

This check box enables (checked), or disables (unchecked), multiple alarms in a single host transmission.

Scan Duration & Frequency

The next two options, scan duration and frequency, relate to the tones generated when the scan decoder successfully identifies 
a symbology.

Scan Duration

This numeric input field defines the duration of the tone generated by a successful scan decode, in milliseconds. The default is 
300.

Scan Frequency

This numeric entry field defines the frequency of the scan decode tone in Hertz. The default, zero (0), selects the terminal's 
factory-set default which is terminal model dependent.

By Attribute (3270 only)

This scrolling list entry defines how 3270 field attributes can be used to generate alarms. The choices are off (the default), pen 
for the light pen attribute, num for numeric attribute, hi for high intensity attribute, and hal for high intensity and light pen attributes.

Protected

This check box enables (checked), or disables (unchecked), the processing of the field attribute into audible alarms for all 
protected fields on the display.

Unprotected

This check box enables (checked), or disables (unchecked), the processing of the field attribute into audible alarms for all 
unprotected fields on the display.

Alternate (5250 only)

This check box enables (checked), or disables (unchecked), the conversion of a single digit character at a specified row and 
column on the 5250 display into the corresponding number of audible alarms.

Row

This numeric input field specifies the zero-based row number in the 5250 display of the alternate alarm digit.

Column

This numeric input field specifies the zero-based row number in the 5250 display of the alternate alarm digit.
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Customizing Printers

Clicking on the Printer tab shows the options related to the terminal printer, as shown below.

Type

This scrolling list option defines the type of printer attached to the terminal. The default is none.

Init Object

This feature allows printer initialization commands to be sent to the terminal immediately after the terminal establishes a session. 
This is an advanced integration tool and is described in Chapter 6.

Flag Byte, Row, Column, and Clear Key (3270,5250 only)

This group of options provides 3270 and 5250 host application direct control over the terminal printer. See the “Start and End 
(3270 and 5250 only)” on page 11 for an alternate method. VT/HP applications rely on standard escape sequences for the 
printing function.

Flag Byte

This numeric input field is a decimal value that corresponds to the ASCII-converted value of an EBCDIC character generated by 
the host application. When the Flag Byte is set to a non-zero value, the terminal checks the host display for the value at the 
specified row and column (“Flag Byte, Row, Column, and Clear Key (3270,5250 only)” on page 11). If the Flag Byte is present, 
all data in the display that follows the Flag Byte is routed directly to the printer, up to the next occurrence of a Flag Byte value in 
the display or else the end of the display.

Flag Row

This numeric input field specifies the row (zero-based, range of 0 to23) where the Flag Byte (defined above) is located.

Flag Column

This numeric input field specifies the column (zero-based, range of 0 to79) where the Flag Byte (defined above) is located.

Clear Key

This scrolling list option defines the keystroke transmitted by the terminal after printing has completed. Set the key to noop to 
disable transmission.

Start and End (3270 and 5250 only)

This option group provides the host application direct control over the terminal printer.

Start
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Specifies a unique character sequence that, when encountered in the host display, indicates that all subsequent characters up 
to but not including the End character sequence are to be transmitted to the printer attached to the terminal. The default value is 
blank which also indicates that this option is not in use.

Note: The print data limit is 1.5 K.

End

Specifies a unique character sequence that terminates collection of data from the host display area for transmission to the printer 
attached to the terminal. The default value is blank which also indicates that this option is not in use.

Start and End Convert (3270/5250 only)

This option group provides for conversion of print data collected with the Start and End option group from ASCII characters in 
hexadecimal format (0-9 and A-F) to binary. The feature allows binary data that might otherwise interfere with the emulation to 
be included in the display area. The host application is responsible for generating the hexadecimal data.

Start Convert

Specifies a unique character sequence (ASCII-converted) within the print data collected with the Start and End options that 
indicates the subsequent character pairs are hexadecimal values that are converted to binary. A blank value, default, indicates 
this option not in use.

End Convert

Specifies a unique character sequence (ASCII-converted) that terminates binary conversion. Default, blank, indicates that this 
option is not in use.

LXE Option (3270/5250 only)

This check box enables (checked), or disables (unchecked) the processing of print data embedded in the datastream according 
to LXE printing rules.

Conversion Flag Byte and Conversion (3270 only)

This option group defines the conversion of a single character (Conversion Flag Byte) found in the 3270 print data, to a printer 
control sequence defined by the Conversion scroll list.

Convert Flag Byte

This numeric input field defines an ASCII value, in decimal, that will be converted to a printer control sequence as defined by the 
Conversion option. The default value is zero (0), which disables conversion.

Conversion

Specifies what the Flag Byte is converted to. The options are crnl, cr, and nl which represent ASCII carriage return new line, 
carriage return, and new line, respectively. The default value is crnl.
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Miscellaneous Customizations

Clicking on the Misc tab shows the following options window:

Extended Command Group (3270 and 5250 only)

This option group provides 3270 and 5250 host applications with the same extended command set available to VT applications. 
See “Extended Commands” on page 16 for a detailed description of the commands.

Start

Specifies a unique character sequence that, when encountered within the host display, indicates that all subsequent characters 
up to but not including the End sequence, are to be interpreted as an Extended Command. Default, blank, indicates that the 
option is not in use.

End

Specifies a unique character sequence that terminates the Extended Command.

Data Stream Group (3270 only)

Send All MDT

This check box enables (checked), or disables (unchecked) the transmission of all fields with the MDT (Modified Data Tag) bit 
set. When disabled, only unprotected fields are transmitted. The default is enabled, which transmits all fields with the MDT set.

Send NULL

This check box enables (checked), or disables (unchecked) the transmission of NULL characters to the host system. The default 
value is disabled. For AS400 hosts, this option must be checked.
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Answerback (VT only)

This text input field defines the response returned to the host application when the answerback command (as defined under VT 
emulation) is received. If this value is left blank, the terminal automatically returns an ASCII string corresponding to the emulation 
in use (VT100 or VT220).

Non-graphic characters may be embedded in the answerback field using the escape sequence \nnn, where the backslash is 
followed by three digits representing the octal value. Refer to ASCII Character Set on page 9-7.

Inserting the sequences “$A,” “$B,” “C,” and “D$” into the answerback string results in a substitution of four octets, three octets, 
two octets, and the last octet of the terminal IP address, respectively, as shown below.

$A - all four octets of the IP address (206.183.067.226)

$B - the last 3 octets (183.067.226)

$C - the last 2 octets (067.226)

$D - the last octet (226)

Given a terminal with an IP address of 206.183.67.226, the following examples demonstrate how substitution and non-graphic 
escape sequences are processed. 

Answerback Data Sent in Response to Answerback Command

Hello World Hello World

$A 206.183.067.226

RF$A RF206.183.067.226

RF$A\015 RF206.183.067.226<carriage return>

$B 183.067.226

RF$B RF183.067.226

RF$B\015 RF183.067.226<carriage return>

$C 067.226

RF$C RF067.226

RF$C\015 RF067.226<carriage return>

$D 226

RF$D RF226

RF$D\015 RF226<carriage return>
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Advanced Integration
This chapter describes the use of the advanced integration features built in to the PowerNet Twin Client. These features make it 
possible to tailor Twin Client operation to meet special customer requirements without custom programming.

Integration objects are used to implement the PowerNet advanced integration capability. An editor is used to create and modify 
each object, and the objects are associated with a terminal configuration using the Advanced setup options described in the 
previous chapter. The objects then become part of the terminal's software configuration and as a result are supported by the 
powerful Auto-Configuration tools described in Chapter 8.

Clicking on the Object Editors menu.

The following sections describe the use of each object, how to create the object, and how to assign the object to a terminal 
configuration using the Advanced Setup options.

A detailed description of the Extended Commands, which are used by applications to dynamically control the terminal scanner 
and keyboard, is included in this chapter. The advanced emulation-specific configuration options referred to in the previous 
chapter are also described here.

Keyboard/Mapping

The Keyboard/Mapping object is used to change the functionality of the terminal keyboard. This feature is most often used to 
simplify keyboard usage and reduce operator workload. It is also used to reduce re-training requirements when introducing new 
terminal models.

The need for keyboard mapping is a result of the size-restricted keypads common to all portable terminal devices. Compensating 
for the physical limitations, the manufacturer uses state modifier keys to expand the functionality of the keypad. As a result, many 
keys (e.g., the UP-ARROW key) require the operator to press two or more keys to emulate a single keystroke. Because many 
applications tend to rely heavily on a small group of keys, it is advantageous to map those frequently used keys to single key 
strokes, thus increasing both productivity and user acceptance.
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Creating the Object

Create the object by clicking on Object Editors, then click on Keyboard/Mapping.

The Keyboard Mapper screen provides a mock-up of a keypad on the left side of the window, and options for key remapping on 
the right. By clicking on a key on the keypad mock-up, the available options that apply to that key appear on the right. For 
example, clicking on the key at the right side of this model changes the display as follows:
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The first column on the right side of the window, entitled Transmit, defines the emulation key assigned to the highlighted keypad 
button in each of the available keyboard states (unshifted, shifted, alpha lock, etc.). Each modified key state is initially blank, 
indicating that the PowerNet default is in effect and no changes will be made to that key or its Mode of operation. Refer to Keypad 
Configurations beginning on page 10-1 for the table of default PowerNet key assignments for each HHP terminal.

After a key is selected, the Mode options change depending on the key selection. The Mode column defines the action taken by 
the selected key combination.

The table of mode options, and their effect, is as follows:

xmit Transmits the key

noop Disables the key

edleft Non-destructive backspace (moves) to the left of the cursor within a field

edrite Non-destructive space (moves) to the right of the cursor within a field

edbksp Destructive backspace (moves) to the left of the cursor within a field

edeeof Erases from current position to end of field

edefld Erases entire field

lhelp Displays terminal ID, date, time, and terminal software version number

scan Activates the scanner
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Saving and Assigning the Object

Save the object by clicking on File, Save As, and then enter a name. For the purposes of this example, the name is vt.

Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on the X button at the upper right corner of 
the Keyboard Mapper window.

Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Keyboard tab, then on the Mapping Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the keyboard mapping will take effect.

Keyboard Macros

The Keyboard/Marco object is used to assign sequences of characters to the VT programmable function keys. Using this feature, 
strings of characters can be assigned to a single keystroke.

Creating the Object

Create the object by clicking on Object Editors, then Keyboard/Macros, and then enter a file name. For the purposes of this 
example, the name is vt.
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Click on the Open button, and then click on the Yes button to create the new file.

The Notepad utility is then invoked. The Keyboard/Macro object is a text file with one entry per line. Each entry uses the following 
format,

<keyname>=<macro string>;

where <keyname> is pf1 to pf24, and <macro string> is the macro text assigned to that specific key. For example, to assign the 
text "VT 100" followed by a carriage return to the pf9 key, the entry is:

Note: \015 represents the octal value for "carriage return". Refer to ASCII Character Set on page 9-7.

Saving and Assigning the Object

Save the object by clicking on File, then on Save, and then on Exit, which returns to the Twin Client Manager menu.

Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Keyboard tab, then on the Macro Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the keyboard macro will take effect.

Scanner/Data Mapping

The scanner data mapping object defines barcode sequences that, when encountered in scanned data, are automatically 
converted to emulator keystrokes. This feature can be used to reduce or eliminate keyboard entry by the operator. That is, instead 
of pressing the PF3 key to access a help screen, the operator scans a barcode that is mapped to the keystroke.

Creating the Object

Create the object by clicking on Object Editors, then Scanner Data/Mapping, and then enter a file name. For the purposes of this 
example, the name is vt.
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Click on the Open button, and then click on the Yes button to create the new file.

The Notepad utility is then invoked. The Scanner/Data mapping object is a text file with one entry per line. Each entry uses the 
following format,

<barcode>=<keystroke>

where <barcode> is the scanned barcode and <keystroke> is the keystroke to send when the barcode is scanned. The following 
example object demonstrates three scan data mappings, including the mapping of barcode $H to the PF3 keystroke.

Saving and Assigning the Object

Save the object by clicking on File, then on Save, and then on Exit, which returns to the Twin Client Manager menu.

Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Scanner tab, then on the Data Mapping Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the scanner data mapping will take effect.
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Scanner/Data Editing

The scanner data editing object defines the rules for recognizing barcode patterns, and then for performing automatic 
manipulations on the barcode before it is transmitted to the host application. This feature is most often employed when upgrading 
wedge-based systems.

Creating the Object

Create the object by clicking on Object Editors, then Scanner/Data Editing.

Bar code recognition is based on the Size (length) and Recognition specifiers. Once the pattern is recognized, Operation 
specifiers manipulate the barcode.

The recognition specifiers consist of the four characters, as shown in the following table.

A Alpha character

N Numeric character

* Any character

= Must match next character

The operation specifiers consist of the following constructs:

X Delete character

* Copy as is

( ) Substitute

""Insert

The following table illustrates how the recognition and operation specifiers identify and manipulate the data.

Bar Code Size Recognition Operation Result

PN-1245 7 AA=-NNNN "F"******* FPN-1245
PowerNet Twin Client™ Version 7.4.0 User’s Guide 6 - 7



Saving and Assigning the Object

Save the object by clicking on File, Save As, and then enter a name. For the purposes of this example, the name is vt.

Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on the X button at the upper right corner of 
the Scan Editor window.

Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Scanner tab, then on the Data Editor Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the scan data editor object will take effect.

Scan/Decoder Control

The scan/decoder control object modifies the operation of the scan decoder in the terminal. Any of the supported symbologies 
can be enabled or disabled, and all of the parameters associated with a specific symbology can be modified to meet specific 
customer requirements.

This feature is used primarily to reduce errors and increase performance. For example, a terminal used in a receiving application 
can be restricted to symbologies used only in the receiving department, thus reducing the opportunity for scan decoder errors 
and, in many cases, increasing scanner performance. As another example, the scan decoder can be instructed to return a 
successful scan only when the barcode is of a certain length. As a result, the opportunity for a scan decoder error is further 
reduced.

PowerNet Twin Client also allows the scanner to be controlled dynamically by the application. This is accomplished through the 
use of the Extended Command set, which is described later in this chapter.

5A5567BBAT 10 ********** **********"M "5A5567BBATM

TGR87 5 =T=GAN* **(S)** TGS87

78-RHG 6 NN=-AAA **X*** 78RHG
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Creating the Object

Create the object by clicking on Object Editors, then Scanner/Decoder Control.

The check box next to the symbology enables (checked) or disables (unchecked) the symbology. The options for a specific 
symbology are available for modification by highlighting the select symbology.

Saving and Assigning the Object

Save the object by clicking on File, Save As, and then enter a name. For the purposes of this example, the name is vt.

Then click on Save. Return to the PowerNet Twin Client Manager menus by clicking on the   button at the upper right corner of 
the Decoder Control window.
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Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Scanner tab, then on the Decoder Control Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the scan decoder control object will take effect.

Display/Mapping

The display mapping object is used to correct variations between application character sets and the terminal display character 
set. The terminal display uses the ISO-8859-1 font set, which is an international standard adhered to by most, but not all, 
applications. The display mapping is used to resolve any discrepancies.

Creating the Object
Create the object by clicking on Object Editors, then Display/Mapping, and then enter a file name. For the purposes of this 
example, the name is vt.

Click on the Open button, and then click on the Yes button to create the new file.
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The Notepad utility is then invoked. The Display/Mapping object is a text file with one entry per line. Each entry uses the following 
format,

<application char>=<ISO-8859-1 char>,xlat;

where <application char> is the hexadecimal value of the character transmitted by the host application, and <ISO-8859-1 
char> is the hexadecimal value of the desired terminal display character, followed by a comma, the word xlat, and a 
semicolon. Tables for both ISO-8859-1 and the ASCII character sets are in Appendix A.

For the purposes of this example, the English character e (0x65) will be converted to an umlaut ë (0xEB)with the entry shown 
below. Note that the two character hexadecimal values must be preceded by 0x.

Saving and Assigning the Object
Save the object by clicking on File, then on Save, and then on Exit, which returns to the Twin Client Manager menu.

Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Display tab, then on the Mapping Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the display mapping object will take effect.

Display/Formatting

The display formatting object is used to make the host application interface easier to use, without modifying the host application. 
Chapter 7 is devoted to the description of this important integration feature.

Printer/Init

The printer initialization object is used to send initialization commands to the printer at the start of each terminal session. It can 
also be used to test printer operation.
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Creating the Object

Create the object by clicking on Object Editors, then Printer/Init, and then enter a file name. For the purposes of this example, 
the name is vt.

Click on the Open button, and then click on the Yes button to create the new file.

The Notepad utility is then invoked. The printer/init object is a text file, allowing for the entry of printer-specific commands. Refer 
to the documentation provided by the printer manufacturer for instructions.

Saving and Assigning the Object

Save the object by clicking on File, then on Save, and then on Exit, which returns to the Twin Client Manager menu.

Next, assign the object to a terminal configuration by opening a terminal configuration from the Files menu. Click on the advanced 
setup Printer tab, then on the Init Object list button, and finally on the object name.

Save the updated terminal configuration by clicking on File, and then Save. The next time the terminal is cold booted, the new 
configuration will be downloaded automatically and the init object will be transmitted to the printer at the start of the next Telnet 
session.
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Dialog

The dialog object is a script used to automate difficult or repetitive user interactions with the host application. It can be used to 
create terminal screens, collect input, generate output, and make decisions based upon terminal keyboard or scanner input, and 
host application data.

Creating the Object

Create the object by clicking on Object Editors, then Dialog. Commands selected from scrolling list on the right are added or 
inserted into the scripting area on the left using the click buttons between the two areas. The bottom left portion of the window is 
used to collect arguments for those commands that require them.

Commands and Arguments

Commands control the actions taken within the script. They can be used to interact both with the host and the terminal, and to 
modify activity based on comparisons of both terminal and host data. The following tables describe each command.
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Commands

Adding Commands

The scrolling list box on the right side of the window is used to select a command. Click on the desired command and then click 
on the Add button to add the command to the dialog script.

Label Defines a target for the conditional branch commands Onfail, Equal, If, Host State, Host 
Scan, and the unconditional branch command, Goto

Goto Causes execution to begin unconditionally and immediately at the named target Label

On Fail Upon detection of a system error, execution continues at the named Label.

Equals If the comparison is equal, branches to Label. Otherwise, execution continues with the 
next command.

If If the conditions of the comparison operator are true, branches to Label. Otherwise, 
execution continues with the next command. The numeric value comparison operators, 
which treat the values being compared numerically, are = (equal). != (not equal), > 
(greater than), and < (less than). The string value comparison operators, which treat the 
values as character strings, are $= (equal) and $!= (not equal).

Set Var Assigns a value to one of up to 36 variables

Change Var Adds to or subtracts from the value of a variable

Concat Adds characters to the end of a variable

Session Returns control of the session to the terminal operator. The operator returns control to 
the dialog object, at the next line, by pressing the key defined as the End Key in the 
Keyboard tab.

Host On Initiates a TCP/IP connection to the host system

Host Off Terminates the TCP/IP connection to the host system

Host Scan Scans the host display for a value, and continues execution at the named label if the 
value is found

Host Update Refreshes the host display. This command is used after data has been sent to the host 
that may change the display, and prior to using the Host Scan or Host State conditional 
branch commands, or a Host Copy command.

Host Send Transmits data and/or a keystroke to the host

Host Copy Copies characters from the host display to a variable

Host State If the state of the session matches the value supplied, execution begins at the named 
Label. The possible values are inactive, meaning the host session has not been 
established, and plu, which means the host session has been established.

Settle Allows time for the host application to settle

Term Enable Initializes the terminal configuration parameters

Term Clear Clears the terminal display of all characters

Term Display Puts a value or the value of a variable on the terminal display

Term input Prompts the terminal operator to input data

Term No 
Echo

Prompts the terminal operator to input data, which will not be echoed on the terminal 
display

Term Wait Waits for any input from the terminal

Term Logoff Terminates the connection to the wireless network

Exit Terminates execution of the dialog object

Sleep Suspends all activity for the specified number of seconds

Var Char Sets the character used internally by the dialog processor to indicate the name of a 
variable. The character is normaLoglly $. This command is used only when the first 
character of a value used in one of the conditional branching commands begins with a $.

Log Writes a message to the terminal log

Comment Inserts documentation in the dialog object
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All commands that require arguments prompt for them in the box at the lower left side of the window. In the example above, the 
Term Display command requires a row number and either a variable or a character string. In this case the display string is Hello 
World. Note that the text entry field scrolls to the right so that text longer than the size of the box can be entered.

Inserting and Deleting Commands

Click on the desired dialog line on the upper left side of the window to highlight the line, then click on the Insert button to insert 
a new command above the selected line, or click on the Delete button to remove the line.

Using Variables and Labels

The dialog object provides up to 36 variables to store temporary data collected during the execution of the script.

These variables can be compared to fixed values or other variables using the if command. If the comparison is true, execution 
branches to the specified label.

Saving and Assigning the Object

Save the object by clicking on File, Save As, and then enter a name. For the purposes of this example, the name is vt.
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Extended Commands

The host application can control the terminal's scanner and keyboard dynamically, while the terminal is in session, by issuing the 
extended commands described in the following sections.

Dynamic Decoder Control
The format and content of the commands that control the scan decoder are described in the following sub-sections.

CODABAR Control

Extended Command:

<ESC>[?0;<state>;<minlen>;<maxlen>;0z

• State: Disable/enable codabar scanning. 0=disabled, 1=enabled.
• Minlen: Minimum valid barcode length. Valid values are 1-54.
• Maxlen: Maximum valid barcode length. The maximum length must be greater than or equal to the minimum length. Valid 

values are 1-54.

CODE 128

Extended Command:

<ESC>[?2;<state>;<minlen>;<maxlen>;0z

• State: Disable/enable code 128 scanning. 0=disabled, 1=enabled.
• Minlen: Specify minimum valid barcode length. Valid values are from 1 to 54.
• Maxlen: Specifies the maximum valid barcode length. The maximum length must be greater than or equal to the minimum 

length. Valid values are from 1 to 54.

CODE 39

Extended Command:

<ESC>[?3;<state>;<minlen>;<maxlen>;<depend>z

• State: Disable/enable code 39 scanning. 0=disabled, 1=enabled.
• Minlen: Specifies the minimum valid barcode length. Valid values are from 1 to 54.
• Maxlen: Specifies the maximum valid barcode length. The maximum length must be greater than or equal to the minimum 

length. Valid values are from 1 to 54.
• Depend: Disable/enable full ASCII code 39 interpretation. 0=disabled, 1=enabled.

CODE 93

Extended Command:

<ESC>[?5;<state>;<minlen>;<maxlen>;0z

• State: Disable/enable code 93 scanning. 0=disabled, 1=enabled.
• Minlen: Minimum valid barcode length. Valid values are 1-54.
• Maxlen: Maximum valid barcode length. The maximum length must be greater than or equal to the minimum length. Valid 

values are 1-54.

INTERLEAVED 2 OF 5

Extended Command:

<ESC>[?7;<state>;<minlen>;<maxlen>;0z

• State: Disable/enable interleaved 2 of 5 scanning. 0=disabled, 1=enabled.
• Minlen: Minimum valid barcode length. Valid values range from 1 to 54.
• Maxlen: Maximum valid barcode length. The maximum length must be greater than or equal to the minimum length. Valid 

values range from 1-54.

EAN-13/UPC-A

Extended Command:

<ESC>[?8;<state>;0;0;0z

• State: Disable/enable EAN-13/UPC-A scanning. 0=disabled, 1=enabled.

EAN-8

Extended Command:

<ESC>[?9;<state>;0;0;0z

• State: Disable/enable EAN-8 scanning. 0=disabled, 1=enabled.
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UPC-E

Extended Command:

<ESC>[?14;<state>;0;0;0z

• State: Disable/enable UPC-E scanning. 0=disabled, 1=enabled.

Supplemental Barcode Handling (UPC/EAN) Options

Extended Command:

<ESC>[?12;<state>;<minlen>;<maxlen>;<depend>z

• State: This flag should always be set to one.
• Minlen: Specifies if two character supplementals are enabled/disabled (only applies to transmit mode 1). 0=no codes with 

two character supplementals decoded, 1=codes with two character supplementals decoded.
• Maxlen: Indicates if five character supplementals are enabled/disabled (only applies to transmit mode 1). 0=no codes with 

five character supplementals decoded, 1=codes with five character supplementals decoded.
• Depend: Specifies the supplemental transmit mode. 0=no supplementals transmitted to host, supplemental enable/disable 

ignored. 1=only codes with the appropriate supplemental (from minlen/maxlen) decoded. 2=all codes sent as is, supplemental 
enable/disable ignored.

Disabling All Decoders

Extended Command:

<ESC>[?z

This command is used to disable all barcodes on the handheld. Typically this would be issued before turning on an individual 
barcode type just to make sure of the state of the active barcodes.
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Input Mode Command
The input mode parameter sent from the application controls (via the host application) whether the terminal accepts input from 
the keyboard, the scanner or both. The format of this command is as follows.

<ESC>[!1;<mode>z 

The mode parameter can be one of the following:

Key Input Mode Command
The processing of keyed input can be controlled dynamically, while the terminal is in session. The format of this command is as 
follows.

<ESC>[!2;<mode>z 

The mode parameter can be one of the following:

For example, to allow keyboard input of numeric characters only, use the following sequence:

<ESC>[!1;3z<ESC>[!2;2z

(HEX equivalent: 1B 5B 21 31 3B 33 7A 27 5B 21 32 3B 32 7A)

To reset the terminal back to normal input, use the following sequence:

<ESC>[!1;0z<ESC>[!2;0z

(HEX equivalent: 1B 5B 21 31 3B 30 7A 27 5B 21 32 3B 30 7A)

Mode Action Description

0(default) Scan and Key

Data initially accepted from either 
the keyboard or scanner. 
Scanning, allowed on a partially 
keyed field, causes the keyed 
data to be discarded and the 
scanned data to be accepted.

1 Scan and Key

Data initially accepted from either 
the keyboard or scanner. 
Scanning is not allowed on a 
partially keyed field. If the 
operator clears the field then 
scanning is again allowed.

2 Scan Only

Data accepted only from the 
scanner. Use caution when using 
this command, bad barcode can 
block the user from completing 
input.

3 Key Only Data accepted only from 
keyboard, the scanner off

Mode Description

0(default) Accepts characters between 0x20 and 0x7F

1 Accepts alphabetic cha

2 Accepts numeric characters only

3 Accepts alphanumeric characters only
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Advanced Display Options for VT

The Advanced button in the advanced view Display tab is active when VT100 or VT220 emulation is selected. This option group 
controls how display attributes are processed, and it can also be used to simulate block mode operation (“Customizing the 
Keyboard” on page 2).

Attribute Mask

This check box group enables (checked), or disables (unchecked), the display of the indicated character attribute. HHP 
character-based terminal displays are capable of displaying only the Reverse and Blinking attributes. All other attributes, if 
enabled, are displayed in Reverse, except for those attributes checked in the Blink Mask group (see below).

Field Mask

The VT100 and VT220 protocols do not support the more efficient block mode of operation that is standard in the 3270 and 5250 
protocols, since there are no VT100 or VT220 protocol commands for defining input fields.

However, PowerNet makes it possible to simulate block mode operation by using video display attributes to define input fields. 
Each box checked in the Field Mask window indicates a video attribute that will be recognized as an input field specification by 
the emulator. During a terminal session with a host, whenever the cursor is positioned on character with the selected attribute(s), 
all characters to the right of that position with the same attribute are interpreted to specify the length of the input field.

Blink Mask

This check box group is used to enable (checked), or disable (unchecked), the conversion of the selected attribute to Blinking.

Advanced 3270 Keyboard Options

The Advanced button in the advanced view Keyboard tab is active when 3270 emulation is selected. The option groups in this 
window are used to automate keystroke generation under the special conditions described in the following subsections. It is also 
used determine the action taken with oversized scans.

Attribute Key

This option is used to automatically transmit a keystroke to the 3270 host when the 3270 field matches the selected attribute. 
The automatic keystroke generation can be based on whether the input is scanned, or keyed, or both.

Note: When this feature is made active (setting the Key to a value other than noop and setting the Scan Field and or Key Field 
to a value other than off) it overrides all other automatic keystroke generation rules except for the Last Field Keys rules 
(described later in this section).

Key

This scrolling list box is used to select the 3270 keystroke sent with scanned or keyed input when the field matches the selected 
attribute setting specified in Scan Field and Key Field (described below). This option overrides all other automatic keystroke 
generation, except for Last Field processing. The default key setting of NOOP disables this function.

Scan Field

This scrolling list box selects the 3270 field attribute that, when data is scanned into the field, results in automatic transmission 
of the selected Key with the data to the host. The choices are pen (for 3270 Light Pen Enabled), num (for 3270 Numeric Only), 
hi (for 3270 High Intensity) and hal (for 3270 High Intensity and Light Pen Enabled). The default value is off.

Key Field
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This scrolling list box selects the 3270 field attribute that, when data is keyed into the field and the field is completely filled, results 
in automatic transmission of the selected Key with the data to the host. The choices are pen (for 3270 Light Pen Enabled), num 
(for 3270 Numeric Only), hi (for 3270 High Intensity) and hal (for 3270 High Intensity and Light Pen Enabled). The default value 
is off.

Last Field Keys

This option is used to automate keystroke generation when the keyed or scanned input is into the last field on the 3270 display.

Note: When this rule generates a keystroke, it overrides all other automatic keystroke generation rules (i.e., Scan Key, Auto Send 
Key, and Attribute Key).

Scanned Input

This scrolling list box is used to select the 3270 keystroke to be sent when data is scanned into the last field on the 3270 display. 
The default value is noop, which disables this function.

Keyed Input

This scrolling list box is used to select the 3270 keystroke to be sent when data is keyed into the last field on the 3270 display, 
and the field is filled. The default value is noop, which disables this function.

Multiple Fields

This check box enables (checked) the Last Field Keys group only if the host display contains more than one input field.

Key Wrap

This check box enables (checked), or disables (unchecked) the automatic wrapping of oversized scanned input to subsequent 
3270 input fields.

Note: This option has no effect if either Length Checking or Truncation options are enabled (“Customizing the Keyboard” on 
page 2).

 NEW ENVIRON Telnet Extension

The NEW ENVIRON Telnet extension, also known as Workstation ID, is a mechanism for providing named variables with values 
to the host system via a Telnet negotiation at the beginning of each terminal session. The New Environ option under the Twin 
Client Manager's Settings menu is used to create the variables, which are applied to all terminal configurations. Variables can 
be created that apply only to specific terminals (indicated by IP address). It is also possible to create variables that apply to all 
terminals.
6 - 20  PowerNet Twin Client™ Version 7.4.0 User’s Guide



Creating Common Settings

Variables that apply to all terminal sessions are created by selecting Common to all terminals, entering the Variable and Value, 
and clicking Set.

The variable and its value are then displayed in the Current Settings section.

Creating Terminal Specific Settings
Variables that apply to specific terminal sessions are created by selecting Terminal Specific, entering the last two octets of the 
terminal IP address, entering the Variable and Value, and clicking Set.

Select Show all settings to display both terminal specific and common variables in the Current Settings section.
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Changing and Deleting Settings

Variable names and their values can be modified or deleted by clicking on the variable in the list window. Change the variable or 
value by editing the Variable and/or Value boxes, and click on the Set button. To delete the variable, press the Delete key on the 
PC. Deleted variables will continue to appear in the pull down list until after the settings have been saved.

Click on the OK button to save New Environ settings.

TN3270E Negotiation

The following defines the TN3270E negotiation, permitting the transfer of some of the TN3270E Sub-negotiation variables such 
as Lunames from the Telnet terminal to the host during session initialization.

Note: This pertains to 3270 emulation.

TN3270E is implemented on OpenAir Linux using two text files located in the working directory (refer to /etc/.CRF/WORKDIR). 
The tnenvcom.cf file allows for the definition of variables that will be shared by all devices, and the tnenv.cf file allows for the 
definition of terminal-specific variables. These files are currently created and maintained with the system editor.

Line Entry Format, tnenvcom.cf:

VARIABLE=VALUE;

Example *DEVTYP=IBM-3278-2;*CONNECT=RFZ81;

This will assign all terminals the luname of RFZ81.

Line Entry format, tnenv.cf:

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…!

Where IDENT is either the last two octets of the terminal's IP address, or the three digit Spectrum address (065-511). Multiple 
variables can be defined, separated by semi-colons. The entry is terminated with an exclamation.

Example file:

#IP terminals fully qualified octets 7 characters:

010.031:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.001;!

010.032:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.002;!

This will assign the terminal with an IP address of xxx.yyy.010.031 a device type of IBM-3278-2 to the luname of RF3278.001.

New Environ Negotiation

The following defines the New Environ negotiation, permitting the transfer of environmental variables from the Telnet terminal to 
the host during session initialization.

Note:  This pertains to the 5250 and VT emulations.

New Environ is implemented on OpenAir Linux using two text files located in the working directory (refer to /etc/.CRF/WORKDIR). 
The tnenvcom.cf file allows for the definition of variables that will be shared by all devices, and the tnenv.cf file allows for the 
definition of terminal-specific variables. These files are currently created and maintained with the system editor.

Line Entry Format, tnenvcom.cf:

VARIABLE=VALUE;

Line Entry format, tnenv.cf:

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…!

Where IDENT is either the last two octets of the terminal's IP address, or the three digit Spectrum address (065-511). Multiple 
variables can be defined, separated by semi-colons. The entry is terminated with an exclamation.

Example file:

#IP terminals fully qualified octets 7 characters:

010.031:DEVNAME=RF5291.001;!

#Spectrum ONE fully qualified radio ID 3 characters

065:DEVNAME=RF5291.002;!
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7

P

The Display Formatter
Overview

The display formatter adapts full screen Telnet applications to the portable terminal environment without any modification to the 
host application. This powerful tool is included with PowerNet Twin Client, and is also used with the OpenAir server when the 
Twin Client is operating the server-based "thin" mode.

This screen capture utility (included with the Twin Client Manager) is used to access the host application via Telnet and "capture" 
the host displays. Once captured, the screens are processed into a screen formatter object and assigned to a terminal 
configuration, which can then be downloaded automatically to the terminal, over the wireless network.

Features

The PowerNet Display Formatter provides the following unique features:

• Performance - Optimized for minimum run-time overhead and maximum speed.
• Transparency - Fully transparent to the host application.
• Capacity - Up to 128 host screens per object, 16 terminal screens per host screen, and 32 input fields per terminal screen.
• Simplicity - Intuitive drag-and-drop interface for screen capture and formatting.
• Flexibility - Supports all Twin Client terminals.

This chapter describes how to set the emulation, capture the host application displays, and process them into formatter objects 
for download to the terminal.

Setting the Emulation

The first step in the formatting process is to set the emulation (VT, 3270, or 5250) in preparation for capturing the host application 
displays. Click on Start > Programs > PowerNet > Twin Client Manager.

Go to Settings > Emulation and select terminal emulation type from the list.

Then click on OK to return to the main PowerNet Twin Client menu.

Starting the Emulator

Start the emulator by clicking Object Editors > Screen Capture. The emulation window is displayed. Go to Session > Session 
Settings.
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Enter the Host IP address and port of the host system, and then click OK to return to the emulator main menu.

Note: The Host Port of 23 is standard for Telnet. However, for security reasons the port number may be set to other values. 
Consult the local network administrator if a connection cannot be established on port 23.

To Start a Telnet Session with the Host 

Click on the  toolbar icon, or go to Session > Connect. In this example, the 5250 emulator is used and the host system is 
an IBM AS/400.

The host application displays are now ready to be captured.
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Taking Snapshots

The host screens are captured by clicking on the  icon on the toolbar while the desired screen is displayed. Alternately, click 
on Session and then Snapshot. The following pop-up indicates that the screen was captured.

Click OK and continue to navigate the host application, taking snapshots of the screens to be formatted.

Saving the Screen File

Save snapshots at any time by clicking on the  toolbar icon. You can also go to File > Save As. The following window is 
displayed for entering the filename.

Enter the File name; for this example, the filename is set to app1. Then click on the Save button to return to the emulator.

Exiting the Emulator

The telnet session is ended by clicking on the  toolbar icon, or by clicking on Session and Disconnect. Return to the Twin 
Client Manager window to format the screens by clicking on the X icon at the top right corner of the emulator, or by clicking on 
File and Exit.
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Formatting

The screen file created in the previous sections can now be formatted. This section describes how to start the formatter, open a 
screen file, format the screens, save the formatted object, and finally to assign it to a configuration.

Starting the Formatter

The formatter is started from the Twin Client Manager menu. Start the Twin Client Manager by going to   
Start>Programs>Powernet>Twin Client Manager. 

Go to Object Editors > Display/Formatting. The formatter window is displayed. 

To open the screen file, go to File > Open.

Select the screen filename and click the Open button. The formatter window is displayed, including the first host display that was 
captured. The terminal display window, which is blank at this time since no formatting has taken place.

Note: The Terminal display window floats on top of the host screen. If it needs to be moved, click on the title bar and drag it to 
a different area of the host screen.
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Setting Up the Formatter

The terminal display must be set to match the terminal for which the formatter object is to be created. Click on the Tools menu 
and then Setup.

Click on the desired Terminal Screen size, and also ensure that the Host Screen size is set correctly. Then click on OK to return 
to the formatter.

Copying an Input Field

An input field is copied from the host display to the terminal display by the same method used to copy text. Click the left side of 
the input field and drag the cursor to the right. The input field will be highlighted. Now click on the field again and drag it to the 
desired position in the Terminal display.
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Adding an Input Field

To add an input field, create text in the screen formatter window, highlight it, and chose Add Input Field from the Host menu. 
The input filed added in the example below is a lower-case letter "x".

Adding and Copying Variable Display Text

Variable text can be added to the terminal display by clicking on the Terminal window, moving the cursor to the desired display 
position, and typing in the text (in this case, variable text) as shown below.

To do this, move the cursor to the desired position in the host display and hold down the mouse button while moving the cursor 
to the right. Then, right-click on the text to be copied. This text will be highlighted as shown by the words "variable text" copied 
below. Then drag the highlighted text to the desired position in the terminal display and release the mouse button.
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Deleting a Field

Select the text to be deleted by highlighting it, and choose Delete Field from the Host menu.
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Finding a Field on the Terminal

To find a field on the terminal, go to Host > Find Field on Terminal.

Adding an Ident

Formatting requires that each host screen to be uniquely identified. One way to do this is to highlight unique text on the host 
screen (click on the left side of the text and drag the mouse to the right). Then click on the right mouse button, as show below.

From the pull down menu, click on Add Ident. The highlighted field is now colored red on the host display, indicating that it is an 
Ident field. Up to 32 items can be highlighted on each host screen, so if a number of screens share similar features, they can be 
uniquely identified by adding more Idents. In the event that a group of host displays differ only by position of input fields, input 
fields can be used for Idents also.
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Removing an Ident

Remove an Ident field by highlighting it, and then selecting Remove Ident from the Host menu.

Navigating the Screen Formatter

To move to the first screen in the screen formatter, choose First Screen from the Host menu.
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To move to the next screen, select Next Screen from the Host menu.

To move to the previous screen, select Previous Screen from the Host menu.
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To move to the last screen, select Last Screen from the Host menu.

Adding a Terminal Screen

New terminal screens are created by using the New button at the bottom of the Terminal display window. This is useful when 
more that one terminal screen is required to format the relevant data on the host screen. Up to 16 terminal displays can be 
associated with each formatted host display. These are called terminal pages, and the page that is displayed on the terminal at 
any point in time depends on the location of the host cursor position. The page to which the corresponding input field is formatted 
is the one displayed. When multiple pages are present, directional arrows are used to navigate through the pages.

Deleting a Screen

To delete a screen, select Delete Screen from the Host menu.
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Saving the Formatter Object

The formatter object is saved by clicking on the  toolbar icon, or by clicking on File and Save.

Assigning the Object to a Terminal Configuration

The formatter object is assigned to a terminal configuration by opening a terminal configuration in the Twin Client Manager, 
assigning the object to the Display Formatting Object, and saving the configuration.

To open a terminal configuration in the Twin Client Manager, click on File > Open.

Select the desired terminal configuration and click Open.

Click on the advanced view Display tab, and select the object from the Formatter Object drop-down list.

Save the newly modified terminal configuration using the  toolbar icon, or click on File > Save. The new configuration, 
incorporating the formatter object, is updated on the terminal, automatically, by cold booting the terminal.
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Software Management
In addition to providing functions for downloading files to the terminal via the traditional serial connection, the Twin Client Manager 
also provides for the management of terminal software and configurations automatically, over the wireless network.

This chapter describes the automated capability in detail. Additional manual operations involving serial download options are 
described at the end of this chapter.

AirLoader Auto-Configuration

The Airloader Auto-Configuration from is accessed from the Twin Client Manager Settings menu. Select Airloader

Note: If no options are displayed, click the Advanced button.

Enabling Automatic Downloads
Check the Allow terminal to be automatically configured via RF box to enable automatic downloading. In the event another 
PC on the network is already configured and active, the following warning message is displayed.

Synchronizing Configuration Files
Check in the Synchronize Configurations Files box to enable automatic synchronization of configuration files on the terminal. 
When the terminal is cold booted, its configuration files will be compared with the most recent on the PC. The terminal is updated 
automatically if it does not have the latest revision.

Synchronizing Program Files
Check in the Synchronize Program Files box to enable automatic synchronization of program files on the terminal. When the 
terminal is cold booted, its program files will be compared with the most recent on the PC. The terminal is updated automatically 
if it does not have the latest revision.

Automatic IP Address Assignment
New terminals will be assigned IP addresses automatically if the following box is checked.

Note: Do not check this box if a DHCP server is configured to manage address assignments.
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To set the addresses, click on the Addresses button to access the Segment Address Assignments dialog box, as shown in the 
following figure.

Enter the desired range in the From and To boxes as shown above, and then click on Add.

Creating New Groups
New groups, with different configurations, can be created by clicking on the Terminal Group Manager, and then clicking the 
right mouse button.
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After the new group has been created, the group settings option become available for change, as shown below.

After the Configuration File and all of the other parameters have been set, the group is made active by clicking on the Active 
check box.
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Clicking on the Thin Mode button will cause all terminals in this group that are currently running in thick mode to be switched to 
thin mode the next time Airloader in run on the terminal.

Click on the Schedule button to view a dialog box for scheduling an automatic Airloader update.

Select the desired time and click on OK. Click on Update Now, and the Airloader "push" capability controls terminals from this 
end.

Setting the Segment

Checking the Segment button restricts a terminal group to a range of IP addresses. The IP Address can be any valid address 
on the segment as it is used only to identify the segment. The setting of the Net Mask can be used to restrict the range. This 
feature is useful for segregating terminal groups by location.

Setting Force Reload

Clicking on the Force Reload button forces all terminals within a group to be automatically updated. The following warning 
message appears:

Click on the Yes button to force the reload.

Setting the Default Terminal Group
New terminals that have not yet been assigned to any group are initially assigned to the default group in effect when they are 
cold booted.

Any group can be made the default group by clicking on the group, and then clicking on the right mouse button. Then click on 
the Make Default option.
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Reassigning Terminals
After a terminal has been configured and assigned to the default group, it can be reassigned to a new group by clicking on the 
terminal icon as shown below.

Then, holding the mouse button down, drag the terminal icon to the desired group as shown next.

Release the mouse button, which reassigns the terminal. The next time the terminal is rebooted, it will be reconfigured as defined 
in the group specification.

Tools Menu

The Tools menu contains many features.

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal Messenger features depending on its 
authorization codes.
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Screen Watcher
Go to Tools > Screen Watcher.

Enter the terminal's IP address, and click OK. A screen appears that resembles the terminal screen.

Clicking the Font button on the upper left brings up a screen in which you can modify the font settings.
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Terminal Messenger
Go to Tools > Terminal Messenger. 

You may enter an Address Range in the From and To boxes on this screen. Click on Add when finished.

Enter a message to send in the space provided, select the terminal to receive this message in the Select Terminal(s) column, 
and click on the Send button to send the message of your choice to the terminal of your choice.

To remove a terminal from the list of terminals receiving your message, click on the terminal number in the Select Terminal(s) 
column, and click on the Remove button. Click on the appropriate button, Remove All, Select All, or Unselect All, to remove 
all terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list.

Note: Use the Ctrl and Shift keys to select multiple terminals.

Click on the Close button when finished.
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RF Monitor
Go to Tools > RF Monitor.

Go to File > Select Terminal to view a log of the terminal's activity. Enter the Terminal IP Address and set the Terminal IP 
Port to 1802. 

Click OK.

Click Edit > Find and/or Find Next to search for pieces of information in your log. Select Clear to clear the search.

Click on Actions to Start the Monitor or Stop the Monitor.
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Set Debug Levels
Go to Tools > Set Debug Levels. 

Settings
Go to Tools > Settings to set the maximum log file size.

Go to Tools > Server Transfer. The FTP Settings screen appears.

To send object editor and configuration files from Windows to your Linux box, enter your Server address and click OK.
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View Menu

Click on View to show or hide the Toolbar and the Status Bar. 

This is the Toolbar. It is found near the top of the screen.

This is the Status Bar. It is found at the bottom of the screen.
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Sending Configuration Files to Dolphin 7200/7500 Terminals

HHP terminals are normally delivered with HHP software pre-installed. 

The automated configuration management provided by the Twin Client Manager eliminates the need for a serial download of the 
terminal configuration. However, this function can be accomplished manually by clicking Terminal > Send Setup Files to 
Terminal. After safe booting the terminal, type "LD" at the DOS prompt, but do not ENTER at this time.

Note: This procedure assumes that the PowerNet Twin Client was previously installed.

The following screen appears:

Now, choose ENTER on the terminal, while choosing OK at the prompt above.

Cold boot the terminal.

The terminal is now ready to begin a Telnet session with the new setup files.

Sending Configuration Files to Dolphin 74XX/95XX Terminals

1. Cold boot the terminal by pressing and holding the <ESC> and <CTRL> keys for about 10 seconds, then release. 

2. On the terminal, press <ENT>.

3. Connect the terminal to the host PC via ActiveSync. 

4. On the PC, go to Terminal > Send Configuration Files to Terminal. The following screen displays.

5. Click Yes. The following window appears.

6. Click OK.

7. Cold boot the terminal.

8. On the terminal, select the Specify an IP Address button.

9. Enter the IP Address, Subnet Mask, and Default Gateway.

10. Click OK.

11. Go to Start > Programs > Cisco > Client Utility.

12. Select SSID and its Value.
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13. Click OK.

14. Go to Start > Programs > Cisco > Client Utility.

15. Select World Mode, and change the value to Disabled.

16. Click OK.

17. Warm boot the terminal.

Sending Program Files to the Dolphin 74XX/95XX Terminal

1. Cold boot the terminal.

2. On the terminal, press <ENT>.

3. Double-click on the My Computer icon.

4. Double-click on the IPSM icon.

5. Select the TwinClient folder.

6. Choose Delete from the File menu.

7. Choose Yes at the prompts.

8. Press <ENT>. Steps 1-8 clear the previous version.

9. Connect the terminal to the host PC via ActiveSync.

10. On the PC, go to Terminal > Send Program Files to Terminal. The following screen appears. 

11. Click OK.

12. On the terminal, select the Specify an IP Address button.

13. Enter the IP Address, Subnet Mask, and Default Gateway.

14. Click OK.

15. Go to Start > Programs > Cisco > Client Utility.

16. Select SSID and its Value.

17. Click OK.

18. Go to Start > Programs > Cisco > Client Utility.

19. Select World Mode, and change the value to Disabled.

20. Click OK.
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Character Sets
ISO 8859-1 Character Set

Description Char Dec Hex

non-breaking space 160 A0

inverted exclamation ¡ 161 A1

cent sign ¢ 162 A2

pound sterling £ 163 A3

general currency sign ¤ 164 A4

yen sign ¥ 165 A5

broken vertical bar ¦ 166 A6

section sign § 167 A7

umlaut (dieresis) ¨ 168 A8

copyright © 169 A9

feminine ordinal ª 170 AA

left angle quote, guillemot left « 171 AB

not sign ¬ 172 AC

soft hyphen - 173 AD

registered trademark ® 174 AE

macron accent ¯ 175 AF

degree sign ° 176 B0

plus or minus ± 177 B1

superscript two ² 178 B2

superscript three ³ 179 B3

acute accent ´ 180 B4

microsign µ 181 B5

paragraph sign ¶ 182 B6

middle dot · 183 B7

cedilla ¸ 184 B8

superscript one ¹ 185 B9

masculine ordinal º 186 BA

right angle quote, guillemot right » 187 BB

fraction one-fourth ¼ 188 BC
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fraction one-half ½ 189 BD

fraction three-fourths ¾ 190 BE

inverted question mark ¿ 191 BF

capital A, grave accent À 192 C0

capital A, acute accent Á 193 C1

capital A, circumflex accent Â 194 C2

capital A, tilde Ã 195 C3

capital A, dieresis or umlaut mark Ä 196 C4 

capital A, ring Å 197 C5

capital AE diphthong (ligature) Æ 198 C6

capital C, cedilla Ç 199 C7

capital E, grave accent È 200 C8

capital E, acute accent É 201 C9

capital E, circumflex accent Ê 202 CA

capital E, dieresis or umlaut mark Ë 203 CB

capital I, grave accent Ì 204 CC

capital I, acute accent Í 205 CD

capital I, circumflex accent Î 206 CE

capital I, dieresis or umlaut mark Ï 207 CF

capital Eth, Icelandic Ð 208 D0

capital N, tilde Ñ 209 D1

capital O, grave accent Ò 210 D2

capital O, acute accent Ó 211 D3

capital O, circumflex accent Ô 212 D4

capital O, tilde Õ 213 D5

capital O, dieresis or umlaut mark Ö 214 D6

multiply sign × 215 D7

capital O, slash Ø 216 D8

capital U, grave accent Ù 217 D9

capital U, acute accent Ú 218 DA

capital U, circumflex accent Û 219 DB

ISO 8859-1 Character Set

Description Char Dec Hex
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capital U, dieresis or umlaut mark Ü 220 DC

capital Y, acute accent Ý 221 DD

capital THORN, Icelandic Þ 222 DE

small sharp s, German (sz ligature) ß 223 DF

small A, grave accent à 224 E0

small A, acute accent á 225 E1

small A, circumflex accent â 226 E2

small A, tilde ã 227 E3

small A, dieresis or umlaut mark ä 228 E4

small A, ring å 229 E5

small AE diphthong (ligature) æ 230 E6

small C, cedilla ç 231 E7

small E, grave accent è 232 E8

small E, acute accent é 233 E9

small E, circumflex accent ê 234 EA

small E, dieresis or umlaut mark ë 235 EB

small I, grave accent ì 236 EC

small I, acute accent í 237 ED

small I, circumflex accent î 238 EE

small I, dieresis or umlaut mark ï 239 EF

small Eth, Icelandic ð 240 F0

small N, tilde ñ 241 F1

small O, grave accent ò 242 F2

small O, acute accent ó 243 F3

small O, circumflex accent ô 244 F4

small O, tilde õ 245 F5

small O, dieresis or umlaut mark ö 246 F6

division sign ÷ 247 F7

small O, slash ø 248 F8

small U, grave accent ù 249 F9

small U, acute accent ú 250 FA

ISO 8859-1 Character Set

Description Char Dec Hex
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small U, circumflex accent û 251 FB

small U, dieresis or umlaut mark ü 252 FC

small Y, acute accent ý 253 FD

small THORN, Icelandic þ 254 FE

small Y, dieresis or umlaut mark ÿ 255 FF

ISO 8859-1 Character Set

Description Char Dec Hex
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ASCII Character Sets

Decimal and Hexadecimal Values

Dec Hex Dec Hex Dec Hex Dec Hex

NUL 0 00 SP 32 20 @ 64 40 ` 96 60

SOH 1 01 ! 33 21 A 65 41 a 97 61

STX 2 02 " 34 22 B 66 42 b 98 62

ETX 3 03 # 35 23 C 67 43 c 99 63

EOT 4 04 $ 36 24 D 68 44 d 100 64

ENQ 5 05 % 37 25 E 69 45 e 101 65

ACK 6 06 & 38 26 F 70 46 f 102 66

BEL 7 07 ´ 39 27 G 71 47 g 103 67

BS 8 08 ( 40 28 H 72 48 h 104 68

HT 9 09 ) 41 29 I 73 49 i 105 69

NL 10 0A * 42 2A J 74 4A j 106 6A

VT 11 0B + 43 2B K 75 4B k 107 6B

NP 12 0C , 44 2C L 76 4C l 108 6C

CR 13 0D - 45 2D M 77 4D m 109 6D

SO 14 0E . 46 2E N 78 4E n 110 6E

SI 15 0F / 47 2F O 79 4F o 111 6F

DLE 16 10 0 48 30 P 80 50 p 112 70

DC1 17 11 1 49 31 Q 81 51 q 113 71

DC2 18 12 2 50 32 R 82 52 r 114 72

DC3 19 13 3 51 33 S 83 53 s 115 73

DC4 20 14 4 52 34 T 84 54 t 116 74

NAK 21 15 5 54 35 U 85 55 u 117 75

SYN 22 16 6 54 36 V 86 56 v 118 76

ETB 23 17 7 55 37 W 87 57 w 119 77

CAN 24 18 8 56 38 X 88 58 x 120 78

EM 25 19 9 57 39 Y 89 59 y 121 79

SUB 26 1A : 58 3A Z 90 5A z 122 7A

ESC 27 1B ; 59 3B [ 91 5B { 123 7B

FS 28 1C < 60 3C \ 92 5C | 124 7C

GS 29 1D = 61 3D ] 93 5D } 125 7D
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RS 30 1E > 62 3E ^ 94 5E ~ 126 7E

US 31 1F ? 63 3F _ 95 5F DEL 127 7F

Decimal and Hexadecimal Values

Dec Hex Dec Hex Dec Hex Dec Hex
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ASCII Character Set      

Octal Values

Oct Oct Oct Oct

NUL 000 SP 040 @ 100 ` 140

SOH 001 ! 041 A 101 a 141

STX 002 " 042 B 102 b 142

ETX 003 # 043 C 103 c 143

EOT 004 $ 044 D 104 d 144

ENQ 005 % 045 E 105 e 145

ACK 006 & 046 F 106 f 146

BEL 007 ´ 047 G 107 g 147

BS 010 ( 050 H 110 h 150

HT 011 ) 051 I 111 i 151

NL 012 * 052 J 112 j 152

VT 013 + 053 K 113 k 153

NP 014 , 054 L 114 l 154

CR 015 - 055 M 115 m 155

SO 016 . 056 N 116 n 156

SI 017 / 057 O 117 o 157

DLE 020 0 060 P 120 p 160

DC1 021 1 061 Q 121 q 161

DC2 022 2 062 R 122 r 162

DC3 023 3 063 S 123 s 163

DC4 024 4 064 T 124 t 164

NAK 025 5 065 U 125 u 165

SYN 026 6 066 V 126 v 166

ETB 027 7 067 W 127 w 167

CAN 030 8 070 X 130 x 170

EM 031 9 071 Y 131 y 171

SUB 032 : 072 Z 132 z 172

ESC 033 ; 073 [ 133 { 173

FS 034 < 074 \ 134 | 174
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GS 035 = 075 ] 135 } 175

RS 036 > 076 ^ 136 ~ 176

US 037 ? 077 _ 137 DEL 177

Octal Values

Oct Oct Oct Oct
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Keypad Configurations
This chapter describes the default PowerNet key assignments applied to HHP terminals used in Twin Client advanced mode. 
The figures and tables identify the key assignments by terminal model and emulation.

Adhesive decals that reflect the configurations described in this chapter are available for HHP terminals in each of the emulations 
(3270, 5250, and VTERM).

Dolphin 7500 Terminal Keypad Table

The keypad table in this section is organized by emulation. The key values represent the default PowerNet keypad assignments 
applied to the terminal in Twin Client advanced mode. Table entries that are grayed-out indicate the default key assignment. 

7500 Terminal Keypad Table

Key VTERM 3270 5250

a

b

c

d

e

f

g

h

i

j

k

l

m

n

o

p

q

r

s

t

u

v

w

x
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y

z

A <Shift><a> <Shift><a> <Shift><a>

B <Shift><b> <Shift><b> <Shift><b>

C <Shift><c> <Shift><c> <Shift><c>

D <Shift><d> <Shift><d> <Shift><d>

E <Shift><e> <Shift><e> <Shift><e>

F <Shift><f> <Shift><f> <Shift><f>

G <Shift><g> <Shift><g> <Shift><g>

H <Shift><h> <Shift><h> <Shift><h>

 I <Shift><I> <Shift><I> <Shift><I>

J <Shift><j> <Shift><j> <Shift><j>

K <Shift><k> <Shift><k> <Shift><k>

L <Shift><l> <Shift><l> <Shift><l>

M <Shift><m> <Shift><m> <Shift><m>

N <Shift><n> <Shift><n> <Shift><n>

O <Shift><o> <Shift><o> <Shift><o>

P <Shift><p> <Shift><p> <Shift><p>

Q <Shift><q> <Shift><q> <Shift><q>

R <Shift><r> <Shift><r> <Shift><r>

S <Shift><s> <Shift><s> <Shift><s>

T <Shift><t> <Shift><t> <Shift><t>

U <Shift><u> <Shift><u> <Shift><u>

V <Shift><v> <Shift><v> <Shift><v>

W <Shift><w> <Shift><w> <Shift><w>

X <Shift><x> <Shift><x> <Shift><x>

Y <Shift><y> <Shift><y> <Shift><y>

Z <Shift><z> <Shift><z> <Shift><z>

Backtab <Shift><Tab> <Shift><Tab> <Shift><Tab>

Tab

Esc

7500 Terminal Keypad Table

Key VTERM 3270 5250
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Space

Caps Lock

Shift

Ctrl

Alt

Backspace

Enter

Del

1

2

3

4

5

6

7

8

9

0

! <Shift><1> <Shift><1> <Shift><1>

@ <Shift><2> <Shift><2> <Shift><2>

# <Shift><3> <Shift><3> <Shift><3>

$ <Shift><4> <Shift><4> <Shift><4>

% <Shift><5> <Shift><5> <Shift><5>

^ <Shift><6> <Shift><6> <Shift><6>

& <Shift><7> <Shift><7> <Shift><7>

* <Shift><8> <Shift><8> <Shift><8>

( <Shift><9> <Shift><9> <Shift><9>

) <Shift><0> <Shift><0> <Shift><0>

F1

F2

F3

7500 Terminal Keypad Table

Key VTERM 3270 5250
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F4

F5

F6

F7

F8

F9

F10

F11

F12

F11 <Shift><F1> <Shift><F1> <Shift><F1>

F12 <Shift><F2> <Shift><F2> <Shift><F2>

F13 <Shift><F3> <Shift><F3> <Shift><F3>

F14 <Shift><F4> <Shift><F4> <Shift><F4>

F15 <Shift><F5> <Shift><F5> <Shift><F5>

F16 <Shift><F6> <Shift><F6> <Shift><F6>

F17 <Shift><F7> <Shift><F7> <Shift><F7>

F18 <Shift><F8> <Shift><F8> <Shift><F8>

F19 <Shift><F9> <Shift><F9> <Shift><F9>

F20 <Shift><F10> <Shift><F10> <Shift><F10>

F21 <Shift><F11> <Shift><F11> <Shift><F11>

F22 <Shift><F12> <Shift><F12> <Shift><F12>

F21 <Ctrl><F1> <Ctrl><F1> <Ctrl><F1>

F22 <Ctrl><F2> <Ctrl><F2> <Ctrl><F2>

F23 <Ctrl><F3> <Ctrl><F3> <Ctrl><F3>

F24 <Ctrl><F4> <Ctrl><F4> <Ctrl><F4>

/                 forward slash

7500 Terminal Keypad Table

Key VTERM 3270 5250
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`                              accent

-                            hyphen

=                      equal sign

[                    left bracket

]                   right bracket

\              backward slash

;                       semicolon

‘                    apostrophe

,                             comma

.                              period

~                                 tilde <Shift><`> <Shift><`> <Shift><`>

_                    underscore <Shift><-> <Shift><-> <Shift><->

+                  addition sign <Shift><=> <Shift><=> <Shift><=>

{                      left brace <Shift><[> <Shift><[> <Shift><[>

}                      right brace <Shift><]> <Shift><]> <Shift><]>

|        broken vertical bar <Shift><\> <Shift><\> <Shift><\>

:                               colon <Shift><;> <Shift><;> <Shift><;>

“            quotation mark <Shift><’> <Shift><’> <Shift><’>

<                less-than sign <Shift><,> <Shift><,> <Shift><,>

>          greater-than sign <Shift><.> <Shift><.> <Shift><.>

?               question mark <Shift></> <Shift></> <Shift></>

Print Screen/Sys Req

Pause/Break

Scroll Lock

Insert

Home

End

Page Up

Page Down

Num Lock

Roll up --- --- <Alt>< >

7500 Terminal Keypad Table

Key VTERM 3270 5250
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Roll down --- --- <Alt>< >

View up <Ctrl>< > <Ctrl>< > <Ctrl>< >

View down <Ctrl>< > <Ctrl>< > <Ctrl>< >

View left <Ctrl>< > <Ctrl>< > <Ctrl>< >

View right <Ctrl>< > <Ctrl>< > <Ctrl>< >

Lighten <Alt>< > <Alt>< > <Alt>< >

Darken <Alt>< > <Alt>< > <Alt>< >

PA1 --- <Alt><1> ---

PA2 --- <Alt><2> ---

PA3 --- <Alt><3> ---

ERINP --- <Alt><End> <Alt><End>

Attention --- <Alt><a> <Alt><a>

Bottom --- <Alt><b> <Alt><b>

Clear --- <Alt><c> <Alt><c>

Redraw --- <Alt><d> <Alt><d>

Field exit --- --- <Alt><e>

FM --- <Alt><f> <Alt><f>

Field mark --- --- ---

Help <Alt><h> <Alt><h> <Alt><h>

Info <Alt><i> <Alt><i> <Alt><i>

EOF --- <Alt><j> <Alt><j>

Erinp --- <Alt><k> <Alt><k>

Local exit --- <Alt><l> <Alt><l>

Field - --- --- <Alt><m>

New line --- <Alt><n> <Alt><n>

ErEOF --- --- <Alt><o>

Field + --- --- <Alt><p>

Reset --- <Alt><r> <Alt><r>

Sys req --- <Alt><s> <Alt><s>

Top --- <Alt><t> <Alt><t>

7500 Terminal Keypad Table

Key VTERM 3270 5250
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Dup --- <Alt><u> <Alt><u>

Refresh --- <Alt><v> <Alt><v>

Print --- <Alt><w> <Alt><w>

Null end --- <Alt><x> <Alt><x>

Back tab <Alt><y> <Alt><y> <Alt><y>

EndPos --- <Alt><z> <Alt><z>

Ctrl_a <Ctrl><a> <Ctrl><a> <Ctrl><a>

Ctrl_b <Ctrl><b> <Ctrl><b> <Ctrl><b>

Ctrl_c <Ctrl><c> <Ctrl><c> <Ctrl><c>

Ctrl_d <Ctrl><d> <Ctrl><d> <Ctrl><d>

Ctrl_e <Ctrl><e> <Ctrl><e> <Ctrl><e>

Ctrl_f <Ctrl><f> <Ctrl><f> <Ctrl><f>

Ctrl_g <Ctrl><g> <Ctrl><g> <Ctrl><g>

Ctrl_h <Ctrl><h> <Ctrl><h> <Ctrl><h>

Ctrl_I <Ctrl><i> <Ctrl><i> <Ctrl><i>

Ctrl_j <Ctrl><j> <Ctrl><j> <Ctrl><j>

Ctrl_k <Ctrl><k> <Ctrl><k> <Ctrl><k>

Ctrl_l <Ctrl><l> <Ctrl><l> <Ctrl><l>

Ctrl_m <Ctrl><m> <Ctrl><m> <Ctrl><m>

Ctrl_n <Ctrl><n> <Ctrl><n> <Ctrl><n>

Ctrl_o <Ctrl><o> <Ctrl><o> <Ctrl><o>

Ctrl_p <Ctrl><p> <Ctrl><p> <Ctrl><p>

Ctrl_q <Ctrl><q> <Ctrl><q> <Ctrl><q>

Ctrl_r <Ctrl><r> <Ctrl><r> <Ctrl><r>

Ctrl_s <Ctrl><s> <Ctrl><s> <Ctrl><s>

Ctrl_t <Ctrl><t> <Ctrl><t> <Ctrl><t>

Ctrl_u <Ctrl><u> <Ctrl><u> <Ctrl><u>

Ctrl_v <Ctrl><v> <Ctrl><v> <Ctrl><v>

Ctrl_w <Ctrl><w> <Ctrl><w> <Ctrl><w>

Ctrl_x <Ctrl><x> <Ctrl><x> <Ctrl><x>

Ctrl_y <Ctrl><y> <Ctrl><y> <Ctrl><y>

7500 Terminal Keypad Table

Key VTERM 3270 5250
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Dolphin 7500 Keyboard

Ctrl_z <Ctrl><z> <Ctrl><z> <Ctrl><z>

Ctrl ^ <Ctrl><6> <Ctrl><6> <Ctrl><6>

Ctrl _ <Ctrl><-> <Ctrl><-> <Ctrl><->

7500 Terminal Keypad Table

Key VTERM 3270 5250
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Dolphin 35-Key Keypads for Terminal Emulation

Dolphin 74XX 35-Key Keypad Overlays 
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Dolphin 74XX 35-Key Keypad Map for VTERM

Key
SFT

ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

ESC

ALPHA

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT

1 ABC abc Ctrl_a PF11 PF1

2 DEF def Ctrl_d PF12 PF2

3 GHI ghi Ctrl_g PF13 PF3

4 JKL jkl Ctrl_j PF14 PF4

5 MNO mno Ctrl_m PF15 PF5 @

6 PQR pqr Ctrl_p PF16 PF6

7 STU stu Ctrl_s PF17 PF7

8 VWX vwx Ctrl_v PF18 PF8

9 YZ yz Ctrl_y PF19 PF9

. > $ | #

0 ) PF20 PF10 `

, < - % ^

F1 ( / “ ‘

F2 + * ? ;

F3 _ ~ { [

F4 = : } ]

light

SP        BKTAB

DEL

BKSP \ ! &
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CTRL

BLUE

RED

ALT

Dolphin 74XX 35-Key Keypad Map for VTERM

Key
SFT

ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 74XX 35-Key Keypad Map for 3270

Key
SFT

ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC

ALPHA

TAB

ENT EOF ATTN ERINP

LEFT Vwleft PA1 NEWL

UP Vwup PA2 LEXIT

RIGHT Vwrite PA3

DOWN Vwdn

ENT EOF ATTN ERINP

1 ABC abc PF11 PF1

2 DEF def PF12 PF2

3 GHI ghi PF13 PF3

4 JKL jkl PF14 PF4

5 MNO mno PF15 PF5 @

6 PQR pqr PF16 PF6 SREQ

7 STU stu PF17 PF7 RESET

8 VWX vwx PF18 PF8 FM

9 YZ yz PF19 PF9 HOME

. > $ | #

0 ) PF20 PF10 `

, < - % ^

F1 ( / “ ‘

F2 + * ? ;

F3 _ ~ { [

F4 = : } ]

light

SP        BKTAB HELP END

DEL EREOF CLEAR INS
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BKSP \ ! &

CTRL

BLUE

RED

ALT

Dolphin 74XX 35-Key Keypad Map for 3270

Key
SFT

ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 74XX 35-Key Keypad Map For 5250

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC

ALPHA

TAB

ENT FEXIT ATTN ERINP

LEFT Vwleft FLD+ NEWL

UP Vwup Rollup LEXIT

RIGHT Vwrite FLD-

DOWN Vwdn Rolldwn

ENT FEXIT ATTN ERINP

1 ABC abc PF11 PF1

2 DEF def PF12 PF2

3 GHI ghi PF13 PF3

4 JKL jkl PF14 PF4

5 MNO mno PF15 PF5 @

6 PQR pqr PF16 PF6 SREQ

7 STU stu PF17 PF7 RESET

8 VWX vwx PF18 PF8 FM

9 YZ yz PF19 PF9 HOME

. > $ | #

0 ) PF20 PF10 `

, < - % ^

F1 ( / “ ‘

F2 + * ? ;

F3 _ ~ { [

F4 = : } ]

Backlight

SP        BKTAB HELP END

DEL EREOF CLEAR INS
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BKSP \ ! &

CTRL

BLUE

RED

ALT

Dolphin 74XX 35-Key Keypad Map For 5250

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 95XX 35-Key Keypad Overlays 
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Dolphin 95XX 35-Key Keypad Map for VTERM

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC - Contrast

ALPHA

TAB + Contrast

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

1 PF11 PF1

2 ABC abc Ctrl_a PF12 PF2

3 DEF def Ctrl_d PF13 PF3

4 GHI ghi Ctrl_g PF14 PF4

5 JKL jkl Ctrl_j PF15 PF5 @

6 MNO mno Ctrl_m PF16 PF6

7 PQRS pqrs Ctrl_p PF17 PF7

8 TUV tuv Ctrl_t PF18 PF8

9 WXYZ wxyz Ctrl_w PF19 PF9

SP  ^ - ,

0 < PF20 PF10 &

DEL \ ! .

F1 ( / “ ‘

F2 + * ? ;

F3 _ ~ { [

F4 = : } ]

BKSP START

F5 > $ | #

F6 ) BKTAB % ´
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Backlight

CTRL

BLUE

RED

ALT

Dolphin 95XX 35-Key Keypad Map for VTERM

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 95XX 35-Key Keypad Map for 3270

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC CLEAR - Contrast

ALPHA

TAB INSERT + Contrast

ENT EOF ATTN ERINP

LEFT Vwleft PA1 NEWL

UP Vwup PA2 LEXIT

RIGHT Vwrite PA3

DOWN Vwdn

1 PF11 PF1

2 ABC abc Ctrl_a PF12 PF2

3 DEF def Ctrl_d PF13 PF3

4 GHI ghi Ctrl_g PF14 PF4

5 JKL jkl Ctrl_j PF15 PF5 @

6 MNO mno Ctrl_m PF16 PF6 SREQ

7 PQRS pqrs Ctrl_p PF17 PF7 RESET

8 TUV tuv Ctrl_t PF18 PF8 FM

9 WXYZ wxyz Ctrl_w PF19 PF9 HOME

SP  ^ - \ ,

0 < PF20 PF10 &

DEL EREOF ! .

F1 ( / “ ‘

F2 + * ? ;

F3 _ ~ { [

F4 = : } ]

BKSP START

F5 > $ | #

F6 ) BKTAB % ´
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Backlight

CTRL

BLUE

RED

ALT

Dolphin 95XX 35-Key Keypad Map for 3270

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 95XX 35-Key Keypad Map For 5250

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC CLEAR - Contrast

ALPHA

TAB INSERT + Contrast

ENT FEXIT ATTN ERINP

LEFT Vwleft FLD+ NEWL

UP Vwup Rollup LEXIT

RIGHT Vwrite FLD-

DOWN Vwdn Rolldwn

1 PF11 PF1

2 ABC abc Ctrl_a PF12 PF2

3 DEF def Ctrl_d PF13 PF3

4 GHI ghi Ctrl_g PF14 PF4

5 JKL jkl Ctrl_j PF15 PF5 @

6 MNO mno Ctrl_m PF16 PF6 SREQ

7 PQRS pqrs Ctrl_p PF17 PF7 RESET

8 TUV tuv Ctrl_t PF18 PF8 FM

9 WXYZ wxyz Ctrl_w PF19 PF9 HOME

SP ^ - \ ,

0 < PF20 PF10 &

DEL EREOF ! .

F1 ( / “ ‘

F2 + * ? ;

F3 _ ~ { [

F4 = : } ]

BKSP START

F5 > $ | #

F6 ) BKTAB % ´
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Backlight

CTRL

BLUE

RED

ALT

Dolphin 95XX 35-Key Keypad Map For 5250

Key SFT ALPHA CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 43-Key Keypads for Terminal Emulation

Dolphin 74XX 43-Key Keypad Overlays 
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Dolphin 74XX 43-Key Keypad Map For VTERM

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

ESC

NUM

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT

A(a) A 1 Ctrl A PF11 PF1

B(b) B 2 Ctrl B PF12 PF2

C(c) C 3 Ctrl C PF13 PF3

D(d) D Ctrl D “ / ‘

E(e) E 4 Ctrl E PF14 PF4

F(f) F 5 Ctrl F PF15 PF5

G(g) G 6 Ctrl G PF16 PF6

H(h) H < *

I(I) I 7 PF17 PF7

J(j) J 8 Ctrl J PF18 PF8

K(k) K 9 Ctrl K PF19 PF9

L(l) L Ctrl L { ~

M(m) M .

N(n) N 0 PF20 PF10

O(o) O , Ctrl O

P(p) P Ctrl P }

Q(q) Q Ctrl Q > (

R(r) R Ctrl R ? )

S(s) S Ctrl S + : [
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T(t) T Ctrl T UNDER_ = ]

U(u) U Ctrl U % $ ;

V(v) V Ctrl V | ^

W(w) W Ctrl W - # `

X(x) X & \

Y(y) Y Ctrl Y ! @

Z(z) Z Ctrl Z

SP BKTAB BKSP

LIGHT DEL

CTRL

BLUE

RED

ALT

Dolphin 74XX 43-Key Keypad Map For VTERM

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 74XX 43-Key Keypad Map for 3270

Key
SFT

NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

ESC

NUM

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT EOF

A(a) A 1 PF11 PF1

B(b) B 2 PF12 PF2

C(c) C 3 PF13 PF3

D(d) D “ / ‘

E(e) E 4 PF14 PF4

F(f) F 5 PF15 PF5

G(g) G 6 PF16 PF6 ERINP

H(h) H < * END

I(I) I 7 PF17 PF7 INFO

J(j) J 8 PF18 PF8

K(k) K 9 PF19 PF9 INS

L(l) L { ~ DUP

M(m) M . HELP RESET FM

N(n) N 0 PF20 PF10 PA1

O(o) O , CLEAR SREQ PA2

P(p) P } + PA3

Q(q) Q > ( NEWL

R(r) R ? )

S(s) S + : [

T(t) T _ = ]
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U(u) U % $ ;

V(v) V | ^

W(w) W - # `

X(x) X & \

Y(y) Y ! EREOF @

Z(z) Z ATTN HOME LEXIT

SP BKTAB BKSP

LIGHT DEL

CTRL

BLUE

RED

ALT

Dolphin 74XX 43-Key Keypad Map for 3270

Key
SFT

NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 74XX 43-Key Keypad Map for 5250

Key SFT NUM CTRL BLUE RED WHITE
(BLUE 
+RED)

ALT

ESC

NUM

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT FEXIT

A(a) A 1 PF11 PF1

B(b) B 2 PF12 PF2

C(c) C 3 PF13 PF3

D(d) D “ / ‘

E(e) E 4 PF14 PF4

F(f) F 5 PF15 PF5

G(g) G 6 PF16 PF6 ERINP

H(h) H < * END

I(I) I 7 PF17 PF7 INFO

J(j) J 8 PF18 PF8

K(k) K 9 PF19 PF9 INS

L(l) L { ~ Rollup

M(m) M . HELP RESET FM

N(n) N 0 PF10 PF20 FLD-

O(o) O , CLEAR SREQ FLD+

P(p) P } Rolldwn

Q(q) Q > ( NEWL

R(r)        R ? )

S(s) S + : [

T(t) T _ = ]
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U(u) U % $ ;

V(v) V | ^

W(w) W - # `

X(x) X & \

Y(y) Y ! EREOF @

Z(z) Z ATTN HOME LEXIT

SP BKTAB BKSP

LIGHT DEL

CTRL

BLUE

RED

ALT

Dolphin 74XX 43-Key Keypad Map for 5250

Key SFT NUM CTRL BLUE RED WHITE
(BLUE 
+RED)

ALT
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Dolphin 95XX 43-Key Keypad Overlays
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Dolphin 95XX 43-Key Keypad Map For VTERM

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

ESC

NUM

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT

A(a) A 1 Ctrl A PF11 PF1

B(b) B 2 Ctrl B PF12 PF2

C(c) C 3 Ctrl C PF13 PF3

D(d) D Ctrl D “ SEND ‘

E(e) E 4 Ctrl E PF14 PF4

F(f) F 5 Ctrl F PF15 PF5

G(g) G 6 Ctrl G PF16 PF6

H(h) H < END *

I(I) I 7 PF17 PF7

J(j) J 8 Ctrl J PF18 PF8

K(k) K 9 Ctrl K PF19 PF9

L(l) L Ctrl L { ~

M(m) M .

N(n) N 0 Ctrl N PF20 PF10

O(o) O , Ctrl O

P(p) P Ctrl P } /

Q(q) Q Ctrl Q > (

R(r) R Ctrl R ? )

S(s) S Ctrl S + : [

T(t) T Ctrl T UNDER_ = ]
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U(u) U Ctrl U % $ ;

V(v) V Ctrl V | ^

W(w) W Ctrl W - # `

X(x) X & \

Y(y) Y Ctrl Y START

Z(z) Z Ctrl Z ! @

SP BKTAB BKSP

LIGHT DEL

CTRL

BLUE

RED

ALT

Dolphin 95XX 43-Key Keypad Map For VTERM

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 95XX 43-Key Keypad Map for 3270

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

ESC

NUM

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT EOF

A(a) A 1 PF11 PF1

B(b) B 2 PF12 PF2

C(c) C 3 PF13 PF3

D(d) D “ SEND ‘

E(e) E 4 PF14 PF4

F(f) F 5 PF15 PF5

G(g) G 6 PF16 PF6 ERINP

H(h) H < END *

I(I) I 7 PF17 PF7 INFO

J(j) J 8 PF18 PF8

K(k) K 9 PF19 PF9 INS

L(l) L { ~ DUP

M(m) M . HELP RESET FM

N(n) N 0 PF20 PF10 PA1

O(o) O , CLEAR SREQ PA2

P(p) P } / PA3

Q(q) Q > ( NEWL

R(r) R ? ) EREOF

S(s) S + : [

T(t) T _ = ]
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U(u) U % $ ;

V(v) V | ^ @

W(w) W - # `

X(x) X & \ !

Y(y) Y START

Z(z) Z ATTN HOME LEXIT

SP BKTAB BKSP

LIGHT DEL

CTRL

BLUE

RED

ALT

Dolphin 95XX 43-Key Keypad Map for 3270

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 95XX 43-Key Keypad Map for 5250

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

ESC

NUM

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT FEXIT

A(a) A 1 PF11 PF1

B(b) B 2 PF12 PF2

C(c) C 3 PF13 PF3

D(d) D “ SEND ‘

E(e) E 4 PF14 PF4

F(f) F 5 PF15 PF5

G(g) G 6 PF16 PF6 ERINP

H(h) H < END *

I(I) I 7 PF17 PF7 INFO

J(j) J 8 PF18 PF8

K(k) K 9 PF19 PF9 INS

L(l) L { ~ Rollup 

M(m) M . HELP RESET FM

N(n) N 0 PF20 PF10 FLD-

O(o) O , CLEAR SREQ FLD+

P(p) P } / Rolldwn 

Q(q) Q > ( NEWL

R(r) R ? ) EREOF

S(s) S + : [

T(t) T _ = ]
PowerNet Twin Client™ Version 7.4.0 User’s Guide 10 - 35



U(u) U % $ ;

V(v) V | ^ @

W(w) W - # `

X(x) X & \ !

Y(y) Y START

Z(z) Z ATTN HOME LEXIT

SP BKTAB BKSP

LIGHT DEL

CTRL

BLUE

RED

ALT

Dolphin 95XX 43-Key Keypad Map for 5250

Key SFT NUM CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 56-Key Keypads for Terminal Emulation

Dolphin 74XX 56-Key Keypad Overlays 
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Dolphin 95XX 56-Key Keypad Overlays
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Dolphin 74XX/95XX 56-Key Keypad Map for VTERM

SFT CTRL BLUE RED RED +
BLUE
(White)

ALT

SFT

ESC

Light

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT

INS

1 PF11 PF1

2 PF12 PF2

3 PF13 PF3

DEL

4 PF14 PF4

5 PF15 PF5

6 PF16 PF6

SP BKTAB

7 PF17 PF7

8 PF18 PF8

9 PF19 PF9

BKSP

.

0 PF20 PF10

,

A(a) A Ctrl A PF11 PF1

B(b) B Ctrl B PF12 PF2

C(c) C Ctrl C PF13 PF3
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D(d) D Ctrl D “ / ‘

E(e) E Ctrl E PF14 PF4

F(f) F Ctrl F PF15 PF5

G(g) G Ctrl G PF16 PF6

H(h) H < *

I(I) I PF17 PF7

J(j) J Ctrl J PF18 PF8

K(k) K Ctrl K PF19 PF9

L(l) L Ctrl L { ~

M(m) M

N(n) N Ctrl N PF20 PF10

O(o) O Ctrl O ! @

P(p) P Ctrl P }

Q(q) Q Ctrl Q > (

R(r) R Ctrl R ? )

S(s) S Ctrl S + : [

T(t) T Ctrl T UNDER_ = ]

U(u) U Ctrl U % $ ;

V(v) V Ctrl V | ^

W(w) W Ctrl W - # `

X(x) X Ctrl X & \

Y(y) Y Ctrl Y z Z

CTRL

BLUE

RED

ALT

Dolphin 74XX/95XX 56-Key Keypad Map for VTERM

SFT CTRL BLUE RED RED +
BLUE
(White)

ALT
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Dolphin 74XX/95XX 56-Key Keypad Map for 3270

Key SFT CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC

Light

TAB

ENT

LEFT

UP

RIGHT

DOWN

ENT

INS

1 PF11 PF1

2 PF12 PF2

3 PF13 PF3

DEL

4 PF14 PF4

5 PF15 PF5

6 PF16 PF6

SP BKTAB

7 PF17 PF7

8 PF18 PF8

9 PF19 PF9

BKSP

.

0 PF20 PF10

,

A(a) A PF11 PF1

B(b) B PF12 PF2

C(c) C PF13 PF3
PowerNet Twin Client™ Version 7.4.0 User’s Guide 10 - 41



D(d) D “ / ‘

E(e) E PF14 PF4

F(f) F PF15 PF5

G(g) G PF16 PF6

H(h) H < *

I(I) I PF17 PF7

J(j) J PF18 PF8

K(k) K PF19 PF9

L(l) L { ~

M(m) M

N(n) N PF20 PF10

O(o) O ! @

P(p) P }

Q(q) Q > (

R(r) R ? )

S(s) S + : [

T(t) T UNDER_ = ]

U(u) U % $ ;

V(v) V | ^

W(w) W - # `

X(x) X & \

Y(y) Y z Z

CTRL

BLUE

RED

ALT

Roll Up

Roll Down

View up

Dolphin 74XX/95XX 56-Key Keypad Map for 3270

Key SFT CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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View down

View left

View right

PA1 n

PA2 o

PA3 p

Attention m

Field exit

FM r

HOME ENT

EOF ENT

ERINP g

Field - 

LEXIT INS

New line q

Field +

RESET m

DUP l

Backtab SP

End h

Dolphin 74XX/95XX 56-Key Keypad Map for 3270

Key SFT CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
PowerNet Twin Client™ Version 7.4.0 User’s Guide 10 - 43



Dolphin 74XX/95XX 56-Key Keypad Map for 5250

Key SFT CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT

SFT

ESC

Light

TAB

ENT

LEFT Vwleft

UP Vwup

RIGHT Vwrite

DOWN Vwdn

ENT

INS

1 PF11 PF1

2 PF12 PF2

3 PF13 PF3

DEL

4 PF14 PF4

5 PF15 PF5

6 PF16 PF6

SP BKTAB

7 PF17 PF7

8 PF18 PF8

9 PF19 PF9

BKSP

.

0 PF20 PF10

,

A(a) A PF11 PF1

B(b) B PF12 PF2

C(c) C PF13 PF3
10 - 44  PowerNet Twin Client™ Version 7.4.0 User’s Guide



D(d) D “ / ‘

E(e) E PF14 PF4

F(f) F PF15 PF5

G(g) G PF16 PF6

H(h) H < *

I(I) I PF17 PF7

J(j) J PF18 PF8

K(k) K PF19 PF9

L(l) L { ~

M(m) M

N(n) N PF20 PF10

O(o) O ! @

P(p) P }

Q(q) Q > (

R(r) R ? )

S(s) S + : [

T(t) T UNDER_ = ]

U(u) U % $ ;

V(v) V | ^

W(w) W - # `

X(x) X & \

Y(y) Y z Z

CTRL

BLUE

RED

ALT

Roll Up l

Roll Down p

View up

Dolphin 74XX/95XX 56-Key Keypad Map for 5250

Key SFT CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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View down

View left

View right

PA1

PA2

PA3

Attention m

Field exit ENT

FM r

Home ENT

EOF

ERINP g

FIELD - n

LEXIT INS

New line q

Field + o

RESET m

DUP

Backtab SP

End h

Dolphin 74XX/95XX 56-Key Keypad Map for 5250

Key SFT CTRL BLUE RED WHITE
(BLUE + 
RED)

ALT
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Dolphin 7200 Alphanumeric Keypads 

Dolphin 7200 Alphanumeric Keypad Map Legend 

Key <abc>  =  lowercase letter mode  =  Press <Shift> until "abc" appears on bottom left of screen

<ABC> = uppercase letter mode  =  Press <Shift> until "ABC" appears on bottom left of screen

<123>  =  numeric mode  =  Press <Shift> until "123" appears on bottom left of screen
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Dolphin 7200 Alphanumeric Terminal Keypad Map

Key VTERM 3270 5250

F1

F2

F3

F4

On Scan

Enter

Shift

BKSP

Red

Blue

a <abc><A> <abc><A> <abc><A>

b <abc><B> <abc><B> <abc><B>

c <abc><C> <abc><C> <abc><C>

d <abc><D> <abc><D> <abc><D>

e <abc><E> <abc><E> <abc><E>

f <abc><F> <abc><F> <abc><F>

g <abc><G> <abc><G> <abc><G>

h <abc><H> <abc><H> <abc><H>

i <abc><I> <abc><I> <abc><I>

j <abc><J> <abc><J> <abc><J>

k <abc><K> <abc><K> <abc><K>

l <abc><L> <abc><L> <abc><L>

m <abc><M> <abc><M> <abc><M>

n <abc><N> <abc><N> <abc><N>

o <abc><O> <abc><O> <abc><O>

p <abc><P> <abc><P> <abc><P>

q <abc><Q> <abc><Q> <abc><Q>

r <abc><R> <abc><R> <abc><R>

s <abc><S> <abc><S> <abc><S>

t <abc><T> <abc><T> <abc><T>
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u <abc><U> <abc><U> <abc><U>

v <abc><V> <abc><V> <abc><V>

w <abc><W> <abc><W> <abc><W>

x <abc><X> <abc><X> <abc><X>

y <abc><Y> <abc><Y> <abc><Y>

z <abc><Z> <abc><Z> <abc><Z>

A <ABC><A> <ABC><A> <ABC><A>

B <ABC><B> <ABC><B> <ABC><B>

C <ABC><C> <ABC><C> <ABC><C>

D <ABC><D> <ABC><D> <ABC><D>

E <ABC><E> <ABC><E> <ABC><E>

F <ABC><F> <ABC><F> <ABC><F>

G <ABC><G> <ABC><G> <ABC><G>

H <ABC><H> <ABC><H> <ABC><H>

 I <ABC><I> <ABC><I> <ABC><I>

J <ABC><J> <ABC><J> <ABC><J>

K <ABC><K> <ABC><K> <ABC><K>

L <ABC><L> <ABC><L> <ABC><L>

M <ABC><M> <ABC><M> <ABC><M>

N <ABC><N> <ABC><N> <ABC><N>

O <ABC><O> <ABC><O> <ABC><O>

P <ABC><P> <ABC><P> <ABC><P>

Q <ABC><Q> <ABC><Q> <ABC><Q>

R <ABC><R> <ABC><R> <ABC><R>

S <ABC><S> <ABC><S> <ABC><S>

T <ABC><T> <ABC><T> <ABC><T>

U <ABC><U> <ABC><U> <ABC><U>

V <ABC><V> <ABC><V> <ABC><V>

W <ABC><W> <ABC><W> <ABC><W>

X <ABC><X> <ABC><X> <ABC><X>

Y <ABC><Y> <ABC><Y> <ABC><Y>

Dolphin 7200 Alphanumeric Terminal Keypad Map

Key VTERM 3270 5250
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Z <ABC><Z> <ABC><Z> <ABC><Z>

SPC  <Red><BKSP> <Red><BKSP> <Red><BKSP>

Clear --- <Red><Y> <Red><Y>

ESC <Red><Blue><BKSP> --- ---

TAB <Blue><BKSP> <Blue><BKSP> <Blue><BKSP>

1 <123><L> <123><L> <123><L>

2 <123><M> <123><M> <123><M>

3 <123><N> <123><N> <123><N>

4 <123><G> <123><G> <123><G>

5 <123><H> <123><H> <123><H>

6 <123><I> <123><I> <123><I>

7 <123><B> <123><B> <123><B>

8 <123><C> <123><C> <123><C>

9 <123><D> <123><D> <123><D>

0 <123><R> <123><R> <123><R>

F1 <Red><1> <Red><1> <Red><1>

F2 <Red><2> <Red><2> <Red><2>

F3 <Red><3> <Red><3> <Red><3>

F4 <Red><4> <Red><4> <Red><4>

F5 <Red><5> <Red><5> <Red><5>

F6 <Red><6> <Red><6> <Red><6>

F7 <Red><7> <Red><7> <Red><7>

F8 <Red><8> <Red><8> <Red><8>

F9 <Red><9> <Red><9> <Red><9>

F10 <Red><0> <Red><0> <Red><0>

F11 <Blue><1> <Blue><1> <Blue><1>

F12 <Blue><2> <Blue><2> <Blue><2>

F13 <Blue><3> <Blue><3> <Blue><3>

F14 <Blue><4> <Blue><4> <Blue><4>

F15 <Blue><5> <Blue><5> <Blue><5>

F16 <Blue><6> <Blue><6> <Blue><6>
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F17 <Blue><7> <Blue><7> <Blue><7>

F18 <Blue><8> <Blue><8> <Blue><8>

F19 <Blue><9> <Blue><9> <Blue><9>

F20 <Blue><0> <Blue><0> <Blue><0>

F21 --- <Blue>< F1> ---

F22 --- <Blue>< F2> ---

F23 --- <Blue>< F3> ---

F24 --- <Blue>< F4> ---

Roll up --- --- <Red>< F1> 

Roll down --- --- <Red>< F2> 

Darken <Red><Blue><Z> <Red><Blue><Z> <Red><Blue><Z>

Lighten <Red><Z> <Red> <Z> <Red><Z>

Backlight <Blue><Z> <Blue><Z> <Blue><Z>

PA1 --- <Red>< F1> ---

PA2 --- <Red>< F2> ---

PA3 --- <Red>< F3> ---

Field exit --- --- <Red><E>

EOF --- <Red><E> ---

Help --- <Red><J> <Red><J>

Field - --- --- <Red> < F3> 

Field + --- --- <Red> < F4> 

Reset --- <Red><O> <Red><O>

Sys req --- <Red><T> <Red><T>

View up <Red><Blue>< F1> <Red><Blue>< F1> <Red><Blue>< F1> 

View down <Red><Blue>< F2> <Red><Blue>< F2> <Red><Blue>< F2> 

View right <Red><Blue>< F3> <Red><Blue>< F3> <Red><Blue>< F3> 

View left <Red><Blue>< F4> <Red><Blue>< F4> <Red><Blue>< F4> 

"                         quotations <Red><A> <Red><A> <Red><A>

,                               comma <123><F> <123><F> <123><F>
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[                         left bracket <123><K> <123><K> <123><K>

]                      right bracket <123><P> <123><P> <123><P>

{                           left brace <Red><K> <Red><K> <Red><K>

}                        right brace <Red><P> <Red><P> <Red><P>

~                                  tilde <Red><W> <Red><W> <Red><W>

`                               accent <123><W> <123><W> <123><W>

-                              hyphen <123><T> <123><T> <123><T>

/                    forward slash <123><J> <123><J> <123><J>

=                        equal sign <123><Q> <123><Q> <123><Q>

*                             asterisk <123><E> <Blue><E> <Blue><E>

/                    forward slash <123><J> <123><J> <123><J>

+                   addition sign <Red><O> <Blue><O> <Blue><O>

-               subtraction sign <123><T> <Blue><T> <Blue><T>

.                               period <123><S> <123><S> <123><S>

!                     exclamation <Blue><Y> <Blue><Y> <Blue><Y>

@                        "at" sign <123><Y> <123><Y> <123><Y>

#                             pound <Blue><X> <Blue><X> <Blue><X>

$                               dollar <Blue><U> <Blue><U> <Blue><U>

%                    percentage <Blue><V> <Blue><V> <Blue><V>

^                               carat <Blue><W> <Blue><W> <Blue><W>

&                    ampersand <Red><X> <Red><X> <Red><X>

(               left parenthesis <Blue><K> <Blue><K> <Blue><K>

)            right parenthesis <Blue><P> <Blue><P> <Blue><P>

'                      apostrophe <Red><A> <Red><A> <Red><A>

\              backward slash <123><V> <123><V> <123><V>

:                               colon <Red><U> <Red><U> <Red><U>

>          greater-than sign <123><X> <123><X> <123><X>

;                       semicolon <123><U> <123><U> <123><U>

|         broken vertical bar <Red><V> <Red><V> <Red><V>

<                less-than sign <Red><F> <Red><F> <Red><F>

?               question mark <Red><J> <Blue><J> <Blue><J>
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Dolphin 7200 Numeric Keypads

Dolphin 7200 Numeric Keypad Map Legend 

Key <abc>  =  lowercase letter mode  =  Press <Shift> until "abc" appears on bottom left of screen

<ABC> = uppercase letter mode  =  Press <Shift> until "ABC" appears on bottom left of screen

<123>  =  numeric mode              =  Press <Shift> until "123" appears on bottom left of screen
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F1

F2

F3

F4

On Scan

Shift

Enter

BKSP

Period (.)

SP

a <abc><7> <abc><7> <abc><7>

b <abc><7><7> <abc><7><7> <abc><7><7>

c <abc><7><7><7> <abc><7><7><7> <abc><7><7><7>

d <abc><8> <abc><8> <abc><8>

e <abc><8><8> <abc><8><8> <abc><8><8>

f <abc><8><8><8> <abc><8><8><8> <abc><8><8><8>

g <abc><9> <abc><9> <abc><9>

h <abc><9><9> <abc><9><9> <abc><9><9>

i <abc><9><9><9> <abc><9><9><9> <abc><9><9><9>

j <abc><4> <abc><4> <abc><4>

k <abc><4><4> <abc><4><4> <abc><4><4>

l <abc><4><4><4> <abc><4><4><4> <abc><4><4><4>

m <abc><5> <abc><5> <abc><5>

n <abc><5><5> <abc><5><5> <abc><5><5>

o <abc><5><5><5> <abc><5><5><5> <abc><5><5><5>

p <abc><6> <abc><6> <abc><6>

q <abc><6><6> <abc><6><6> <abc><6><6>

r <abc><6><6><6> <abc><6><6><6> <abc><6><6><6>

s <abc><1> <abc><1> <abc><1>

t <abc><1><1> <abc><1><1> <abc><1><1>
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u <abc><1><1><1> <abc><1><1><1> <abc><1><1><1>

v <abc><2> <abc><2> <abc><2>

w <abc><2><2> <abc><2><2> <abc><2><2>

x <abc><2><2><2> <abc><2><2><2> <abc><2><2><2>

y <abc><3> <abc><3> <abc><3>

z <abc><3><3> <abc><3><3> <abc><3><3>

1 <123><1> <123><1> <123><1>

2 <123><2> <123><2> <123><2>

3 <123><3> <123><3> <123><3>

4 <123><4> <123><4> <123><4>

5 <123><5> <123><5> <123><5>

6 <123><6> <123><6> <123><6>

7 <123><7> <123><7> <123><7>

8 <123><8> <123><8> <123><8>

9 <123><9> <123><9> <123><9>

0 <123><0> <123><0> <123><0>

A <ABC><7> <ABC><7> <ABC><7>

B <ABC><7><7> <ABC><7><7> <ABC><7><7>

C <ABC><7><7><7> <ABC><7><7><7> <ABC><7><7><7>

D <ABC><8> <ABC><8> <ABC><8>

E <ABC><8><8> <ABC><8><8> <ABC><8><8>

F <ABC><8><8><8> <ABC><8><8><8> <ABC><8><8><8>

G <ABC><9> <ABC><9> <ABC><9>

H <ABC><9><9> <ABC><9><9> <ABC><9><9>

 I <ABC><9><9><9> <ABC><9><9><9> <ABC><9><9><9>

J <ABC><4> <ABC><4> <ABC><4>

K <ABC><4><4> <ABC><4><4> <ABC><4><4>

L <ABC><4><4><4> <ABC><4><4><4> <ABC><4><4><4>

M <ABC><5> <ABC><5> <ABC><5>

N <ABC><5><5> <ABC><5><5> <ABC><5><5>

O <ABC><5><5><5> <ABC><5><5><5> <ABC><5><5><5>
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P <ABC><6> <ABC><6> <ABC><6>

Q <ABC><6><6> <ABC><6><6> <ABC><6><6>

R <ABC><6><6><6> <ABC><6><6><6> <ABC><6><6><6>

S <ABC><1> <ABC><1> <ABC><1>

T <ABC><1><1> <ABC><1><1> <ABC><1><1>

U <ABC><1><1><1> <ABC><1><1><1> <ABC><1><1><1>

V <ABC><2> <ABC><2> <ABC><2>

W <ABC><2><2> <ABC><2><2> <ABC><2><2>

X <ABC><2><2><2> <ABC><2><2><2> <ABC><2><2><2>

Y <ABC><3> <ABC><3> <ABC><3>

Z <ABC><3><3> <ABC><3><3> <ABC><3><3>

F1 < F1><1> < F1><1> < F1><1>

F2 < F1><2> < F1><2> < F1><2>

F3 < F1><3> < F1><3> < F1><3>

F4 < F1><4> < F1><4> < F1><4>

F5 < F1><5> < F1><5> < F1><5>

F6 < F1><6> < F1><6> < F1><6>

F7 < F1><7> < F1><7> < F1><7>

F8 < F1><8> < F1><8> < F1><8>

F9 < F1><9> < F1><9> < F1><9>

F10 F1><0> < F1><0> < F1><0>

F11 < F2><1> < F2><1> < F2><1>

F12 < F2><2> < F2><2> < F2><2>

F13 < F2><3> < F2><3> < F2><3>

F14 < F2><4> < F2><4> < F2><4>

F15 < F2><5> < F2><5> < F2><5>

F16 < F2><6> < F2><6> < F2><6>

F17 < F2><7> < F2><7> < F2><7>
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F18 < F2><8> < F2><8> < F2><8>

F19 < F2><9> < F2><9> < F2><9>

F20 < F2><0> <vF2><0> < F2><0>

F21 --- < F3><1> < F3><1>

F22 --- < F3><2> < F3><2>

F23 --- < F3><3> < F3><3>

F24 --- < F3><4> < F3><4>

Esc < F2><BKSP> --- ---

Tab < F4><SP> < F4><SP> < F4><SP>

Backspace < F4><BKSP> < F4><BKSP> < F4><BKSP>

Del < F1><BKSP> < F1><BKSP> < F1><BKSP>

$ <ABC><.><.> <ABC><.><.> <ABC><.><.>

% <ABC><.> <ABC><.> <ABC><.>

^ < F4><4> < F4><4> < F4><4>

& < F1><Enter> < F1><Enter> < F1><Enter> 

* < F2><Enter> < F2><Enter> < F2><Enter>

( < F3><Enter> < F3><Enter> F3><Enter>

) < F4><Enter> < F4><Enter> < F4><Enter>

--- <ABC>< F1> <ABC>< F1>

--- <ABC>< F2> <ABC>< F2>

<ABC>< F3 > <ABC>< F3 > <ABC>< F3 >

<ABC>< F4> <ABC>< F4> <ABC>< F4>

Roll down --- --- < F3 ><5>

Roll up --- --- < F3 ><6>

Lighten < F1><SP> < F1><SP> < F1><SP>

Darken < F2><SP> < F2><SP> < F2><SP>

PA1 --- < F3 ><7> ---
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PA2 --- < F3 ><8> ---

PA3 --- < F3 ><9> ---

Clear  --- < F4><5> < F4><5>

Field exit --- --- < F4><3>

EOF --- < F4><8> ---

Help --- --- < F4><9>

Field - --- --- < F3><BKSP>

Reset --- --- < F4><6>

Sys req --- < F4><2> < F4><2>

=                       equal sign < F2><.> < F2><.> < F2><.>

;                       semicolon  < F4><.> < F4><.> < F4><.>

+                  addition sign  < F1><.> < F1><.> < F1><.>

-              subtraction sign < F4><1> < F4><1>  < F4><1>

|           broken vertical bar < F4><7> < F4><7> < F4><7>

<                less-than sign < F3><0> < F3><0> < F3><0>

?                question mark <ABC><.><.><.> <ABC><.><.><.> <ABC><.><.><.>

'                     apostrophe <ABC><3><3><3> <ABC><3><3><3> <ABC><3><3><3>

/                 forward slash < F3><.> < F3><.> < F3><.>

\              backward slash <ABC><0> <ABC><0> <ABC><0>

:                            colon <ABC><0><0> <ABC><0><0> <ABC><0><0>

>           greater-than sign <ABC><0><0><0> <ABC><0><0><0> <ABC><0><0><0>
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HHP Terminal Control Sequence

Safe Mode Boot

Safe Boot Sequences

Terminal Model & Keypad Key Sequence

7200, 7500 To exit to DOS prompt from main screen,press <shift> to view uppercase mode, 
press <C> for Edit Functions screen, press <F2> to Exit, and press <enter>.  
Press <shift> <bksp>and <on scan> keys simultaneously, then release.Press and 
hold <on scan> key until terminal finishes rebooting.

7400/7450, 95XX Press Shift and Ctrl keys simultaneously, hold for 10 seconds, and release. (Often 
referred to as warm boot.)

Cold Mode Boot

Cold Boot Sequences

Terminal Model & Keypad Key Sequence

7200, 7500 To exit to DOS prompt from main screen,press <shift> to view uppercase mode, 
press <C> for Edit Functions screen, press <F2> to Exit, and press <enter>. 
Press <shift> <bksp> and <on scan> keys simultaneously, then release.

7400/7450, 95XX Press ESC and CTRL keys simultaneously, hold for 10 seconds, then release. 
(Often referred to as cold boot.)
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